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Chapter 1
Spartan Student

This chapter describes the architecture of Spartan Student, focusing 
on the connectivity of computational, graphical and database 
components to the user interface. Available molecular mechanics 
and quantum chemical methods are enumerated and their utility and 
applicability assessed.

Spartan Student comprises a series of independent modules tightly 
connected via a graphical user interface that is highly functional, yet 
elementary and uncluttered. It has been designed not only to greatly 
reduce the drudgery and possibility for human error associated with the 
preparation of input, but also to guide the interpretation of output. The 
interface is perhaps best viewed as an interactive and intuitive window 
into modern molecular mechanics and quantum chemical techniques. 

Included in the interface are builders for organic, inorganic and 
organometallic molecules, polypeptides and polynucleotides, and 
a procedure for guessing transition states. Access to ChemDraw1 is 
provided without having to exit the interface. Also accessible is a 
small (~5,000 molecule) subset of the Spartan Spectra and Properties 
Database (SSPD)2 and (if desired) an equally small subset of the Spartan 
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Molecular Database (SMD)3. SSPD contains structures, infrared and 
NMR spectra as well as a wide variety of molecular properties obtained 
from the EDF2/6-31G* density functional model. The wavefunction 
is included, allowing quick access to a variety of graphical surfaces 
and property maps. SMD contains calculated structures and associated 
properties of molecules, each obtained from one or more of the 
theoretical models supported in Spartan Student. On-line access to 
the Protein Data Bank (PDB)4, a collection of >75,000 biological 
macromolecular structures, is provided. Experimental infrared 
spectra are available from the NIST website5 and experimental NMR 
spectra from NMRShiftDB website.6 Finally, compounds contained 
in the National Cancer Institute collection of molecules (CACTUS)7 
may be accessed via name search. Unlike SSPD, SMD and PDB, 
CACTUS contains no actual structure data, only connectivity 
information (allowing construction of an approximate structure).

Spartan Student’s interface provides the gateway to a range of modern 
computational methods, the simplest of which is the MMFF molecular 
mechanics model. It is available to determine equilibrium geometries 
of molecules comprising upwards of several thousand atoms, and is 
the only computational technique that is applicable to biopolymers. It 
may also be employed to establish the best (lowest-energy) conformer 
of organic molecules.

Quantum chemical models are required to account for the geometries 
of transition states as well as for reaction and activation energies.8 
The simplest of these are semi-empirical molecular orbital models. 
The PM3 model, supported in Spartan Student, has proven successful 
for determining equilibrium geometries including the geometries of 
transition-metal compounds, but it is not reliable for the calculation 
of the reaction or activation energies.

Hartree-Fock molecular orbital models are a mainstay of quantum 
chemical techniques, in particular, for determining equilibrium and 
transition-state geometries and reaction energies, and are supported in 
Spartan Student with the STO-3G, 3-21G, 6-31G* and 6-311+G** 
basis sets. Hartree-Fock models generally provide suitable descriptions 
of many types of reactions, but are not adequate for thermochemical 
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comparisons where bonds are broken or formed. In addition, they 
do not provide a proper account of the geometries of molecules 
incorporating transition metals. Supported in Spartan Student are the 
B3LYP and EDF2 density functional models and the MP2 Møller-
Plesset model. All properly account for the energies of reactions 
that involve bond making and breaking and both density functional 
models (but not the MP2 model) properly account for the geometries 
of molecules incorporating transition metals. B3LYP, EDF2 and MP2 
models are supported with the 6-31G* and 6-311+G** basis sets.

Spartan Student provides access to infrared spectra (MMFF, PM3, 
Hartree-Fock, B3LYP, EDF2 and MP2 models) and NMR spectra9 
(B3LYP/6-31G* and EDF2/6-31G* models only). These are available 
both as numerical data (vibrational frequencies, chemical shifts) as 
well as spectral plots. Experimental spectra may be read into Spartan 
Student. In addition, internet access to experimental IR and NMR 
databases5,6 is available allowing direct comparison with calculated 
spectra. Spartan Student allows a calculated infrared spectrum to be 
fit on-the-fly to an experimental spectrum, using both a multiplicative 
scale of calculated frequencies and peak width at half height as 
parameters. Also provided is an empirical correction to 13C NMR 
chemical shifts.

Spartan Student provides a variety of graphical tools to assist in 
interpreting the results of calculations. These include molecular 
orbitals, electron and spin densities, local ionization potentials and 
electrostatic potentials that can be displayed as surfaces, slices and 
property maps. Spartan Student provides the ability to distinguish 
accessible and inaccessible regions on a density surface and on 
property maps based on this surface. Animations can be created and  
used to depict conformational changes or the progress of chemical 
reactions. Animations can be saved as QuickTime files.10
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1. 	 ChemDraw is not included with Spartan Student, but may be obtained from CambridgeSoft  
(www.cambridgesoft.com). Seamless access to ChemDraw is not available in the Macintosh 
version although both Windows and Macintosh versions are able to read ChemDraw files.

2.	 The full Spartan Spectra and Properties Database contains ~110,000 entries from the EDF2/ 
6-31G* density functional model and is available to license. Contact info@wavefun.com 
for more information.

3.	 The full Spartan Molecular Database contains ~150,000 molecules, each with up to 10 
theoretical models and is available to license. Contact info@wavefun.com for more information.

4.	 PDB web reference: http://www.rcsb.org.
5.	 NIST web reference: http://webbook.nist.gov
6.	 NMRShiftDB web reference: http://nmrshiftdb.ice.mpg.de
7.	 CACTUS web reference: http://cactus.nci.nih.gov
8.	 Full discussion and assessment of the specific molecular mechanics and quantum chemical 

models available in Spartan Student is provided in: W.J. Hehre, A Guide to Molecular 
Mechanics and Quantum Chemical Calculations, Wavefunction, Irvine, 2003. This 
is available as a PDF on Wavefunction’s website (www.wavefun.com). See also: W.J. 
Hehre, L. Radom, P.v.R. Schleyer and J.A. Pople, Ab Initio Molecular Orbital Theory, 
Wiley, New York, 1986; Y. Shao, L.F. Molnar, Y. Jung, J. Kussmann, C. Ochsenfeld, S.T. 
Brown, A.T.B. Gilbert, L.V. Slipchenko, S.V. Levchenko, D.P. O’Neill, R.A. DiStasio 
Jr., R.C. Lochan, T. Wang, G.J.O. Beran, N.A. Besley, J.M. Herbert, C.Y. Lin, T. Van 
Voorhis, S.H. Chien, A. Sodt, R.P. Steele, V.A. Rassolov, P.E. Maslen, P.P. Korambath, 
R.D. Adamson, B. Austin, J. Baker, E.F.C. Byrd, H. Dachsel, R.J. Doerksen, A. Dreuw, 
B.D., Dunietz, A.D. Dutoi, T.R. Furlani, S.R. Gwaltney,  A. Heyden, S. Hirata, C-P. Hsu, 
G. Kedziora, R.Z. Khalliulin, P. Klunzinger, A.M. Lee, M.S. Lee, W.Z. Liang, I. Lotan, 
N. Nair, B. Peters, E.I. Proynov, P.A. Pieniazek, Y.M. Rhee, J. Ritchie, E. Rosta, C.D. 
Sherrill, A.C. Simmonett, J.E. Subotnik, H.L. Woodcock III, W. Zhang, A.T. Bell, A.K. 
Chakraborty, D.M. Chipman, F.J. Keil, A.Warshel, W.J. Hehre, H.F. Schaefer, J. Kong, 
A.I. Krylov, P.M.W. Gill and M. Head-Gordon, Phys. Chem. Chem. Phys., 8, 3172 (2006).

9.	 Chemical shifts only. HH coupling constants may be evaluated empirically.
10.	 QuickTime is a multimedia framework developed by Apple, Inc.
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Chapter 2
Operating Spartan Student

This chapter describes the general operating features of Spartan 
Student.

Opening and Exiting Spartan Student

To open on Windows, click on the Start button, then click on All 
Programs, and finally click on Spartan Student (or double click on the 
Spartan Student icon on your desktop). To open on Macintosh, double 
click on the Spartan Student icon in the Applications Folder. To exit, 
select Exit from the File menu (select Quit Spartan Student from 
the Spartan Student menu on Mac), or click the Close button ( ) 
at the top right (  top left on Mac) of the Spartan Student interface.

Menus

Program functions may be accessed using pull-down menus under 
the headings in the menu bar, for example, the Setup menu.

File 	 Allows you to create a new molecule or read in a molecule 
that you have previously saved, to read in an experimental 
IR or NMR spectrum, to retrieve the structure, properties and 
IR and NMR spectra from a molecule in Spartan Student’s 
database from its name, to retrieve a molecular structure 
from the National Cancer Institute (CACTUS) Database, 
to retreive a protein structure from the Protein Data Bank, 
to print, and to make QuickTime movies.

Edit	 Allows you to transfer information to and from the clipboard, 
to undo the last operation, to find text strings, to center 
molecules on screen, and to delete the active molecule.
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Model	 Allows you to control the style of your model, to display 
labels on atoms, to display hydrogen bonds, to couple or 
decouple molecules in a multi-molecule file, and to display a 
Ramachandran plot for a protein structure input from PDB.

Geometry	 Allows you to measure and constrain bond lengths, angles 
and dihedrals, define points and planes, designate atoms to 
be frozen, align molecules, and define points and planes.

Build	 Allows you to build and edit organic, inorganic and 
organometallic molecules, polypeptides and polynucleotides, 
provides access to ChemDraw™ (Windows only), and to 
estimate a transition-state geometry based on a library of 
reactions.

Setup	 Allows you to specify the task to be performed and the 
theoretical model to be employed, to request IR and NMR 
spectra, to specify graphical surfaces and property maps 
and to submit jobs for calculation.

Display	 Allows you to display text output, molecular and atomic 
properties, surfaces and property maps and IR and NMR 
spectra, as well as to access experimental IR, and NMR 
spectra over the internet. Allows you to present data in a 
spreadsheet and make plots from these data, and to compute 
reaction energies based either on your data or from entries 
in the database associated with Spartan Student.

Options	 Allows you to set display standards, specify the location of 
the database and monitor executing jobs.

Help	 Provides access to on-line information about Spartan 
Student.

A complete listing of menu functions is provided in Appendix B.

Icons

Icons access selected functions under the File, Build, and Geometry 
and Display menus, as well as other specialized functions.

File

 New  Open  Close
 Save  Save As  Access Database By Name
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Build
 View  Make Bond  Minimize
 Add Fragment  Break Bond  Guess Transition State
 Delete 

Geometry
 Measure Distance  Constrain Distance 	Define Point
 Measure Angle  Constrain Angle 	Define Plane
 Measure Dihedral  Constrain Dihedral 	Align
 Freeze Center

Display
 Orbital Energies	  Spectra 	Plots

Additional Icons
	Post to Spreadsheet  Guess Transition State
/ 	Lock/Unlock Constraints /  Move Up/Down Dialog
 Play  Pause /  Step

Mouse and Keyboard Operations

The following functions are associated with the mouse.

 button
 keyboard left right

 – selection, X/Y rotate, atom/ X/Y translate
  fragment exchangea, 
  fragment insertiona

 Shift range selection, Z rotate scalingb

 Ctrl global X/Y rotatec global X/Y 
   translate
 Ctrl + Shift multiple selection, scalingb

  global Z rotatec

 Ctrl  fragment X/Y rotate fragment X/Y translate 
 (add fragment mode) chirality inverta,e

 Ctrl + Shift fragment Z rotate scalingb

 (add fragment mode) absolute configuration inverta,e
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 Ctrl + Shiftd (Mac) bond rotation bond stretching
 Alt (Windows) bond rotationd bond stretching

a)	 Requires double clicking.
b)	 Scaling is always applied to all open molecules and all fragments. The center mouse 

wheel may also be used to scale molecules.
c)	 Global rotations can be either molecule or screen centered. This is controlled by Global 

Rotate in the Miscellaneous Preferences dialog (Preferences... under Options menu; 
Chapter 10).

d)	 In Add Fragment mode with bond selected (red arrow visible).
e)	 For Macintosh, Apple () key replaces Ctrl key for chirality inversion.

Mouse/keyboard operations may be broadly separated into two 
categories: selection (picking) and manipulation (translation/
rotation).

Selection. The left button is used for selection of objects on screen 
and/or of menu items. Left and right buttons together are used to define 
a selection box for copying/cutting to the clipboard, as well as for 
multiple model selection. Together with the Shift key, the left button 
allows for selection over a range. Together with the Ctrl (Control) 
key, the left button allows for multiple selection. Both range and 
multiple selection apply not only to text items in lists, but to atoms 
and bonds in molecules as well. In add fragment mode ( ), double 
clicking the left button on an atom leads to atom or fragment exchange. 
Double clicking on an atom with the Ctrl key depressed leads to 
inversion in chirality of the atom and double clicking anywhere on a 
molecule with both Ctrl and Shift keys depressed inverts the absolute 
configuration of the molecule. Given a structure on screen, double 
clicking on the background with a fragment, group, ring or ligand 
selected inserts it alongside (not bonded to) the current structure.

Manipulation. The left button is used for rotation and the right 
button is used for translation and scaling of objects on screen. With 
no keys depressed, the left mouse button gives rise to rotation about 
the X and y (screen) axes, while the right mouse button gives rise 
to translation in the x and y (screen) directions. Together with the 
Shift key, the left mouse button gives rise to rotation about the z 
direction and the right mouse button gives rise to scaling. The center 
(scroll) wheel on the mouse may also be used for scaling.
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The Ctrl key in conjunction with the left or right mouse buttons and 
(optionally) the Shift key, signifies a change in focus away from 
the default for the purpose of rotations and translations. Outside of 
add fragment mode, the default is focus on a single molecule (the 
selected molecule). Use of the Ctrl key changes focus to the entire 
set of molecules on screen, meaning that rotations and translations 
are carried out globally. In add fragment mode, the default is focus on 
the full set of fragments that make up the molecule being constructed, 
and rotations and translations refer to this set of fragments as a 
whole. Use of the Ctrl key changes focus to a single fragment (the 
selected fragment), and rotations and translations now refer only to 
this fragment.

In add fragment mode, use of the Alt key (Windows) or option key 
(Mac) with the left mouse button allows for rotation about a selected 
bond and, with the right mouse button, for changing the length of 
the selected bond.

Additional keys control various Spartan Student functions.

3	 3 selects red-cyan stereo display. Pressing again 
returns to non-stereo display.

Page Up, Page Down	 Moves up (Page Up), down (Page Down), to the top 
Home, End	 (Home) and to the bottom (End) of the set of open 

molecules. Also, moves up and down pages in the 
Output dialog.

Insert	 In add fragment mode only, inserts a new fragment 
on screen. This is accomplished by selecting the 
fragment from the model kit, holding down the 
Insert key and clicking on screen (option key 
on Mac). Insertion may also be accomplished 
by double clicking on the background following 
selection of a fragment.

Delete	 Deletes a fragment, free valence, reaction arrow or 
the contents of a selection box. This is accomplished 
by holding down the Delete key and clicking on 
the fragment, etc.
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Enter	 Required following text or data entry into
(return on Mac)	 spreadsheet or dialogs.

Selecting Molecules, etc.

Two or more molecules may be simultaneously displayed in Spartan 
Student’s window. However, only one molecule may be selected. 
The selected molecule has access to all capabilities (molecule 
building, job setup and submission and text and graphical display 
and manipulation), while non-selected molecules may only be 
displayed as static images. The exceptions involve scaling and the 
use of the Ctrl key.

Selection of a molecule occurs by clicking on its structure model or 
on any of its associated graphical surfaces. This will also result in 
deselection of any previously selected molecule. The name of the 
document and the selected molecule’s label appear at the top of the 
screen. Molecular properties for the selected molecule are available 
in the Properties dialog (Display menu). Atom, bond and surface 
display properties, and information about geometrical constraints 
may be accessed by subsequent clicking on an atom, bond, etc., 
associated with the selected molecule, following which it will be 
highlighted (colored gold). Clicking a second time on the selected 
atom, bond etc., resets the display to molecular properties. Clicking 
on another molecule results in display of molecular properties for 
that molecule.

Where the molecule belongs to a document with more than a single 
member, selection from among the different members in the document 
may be made using either the  and  buttons or the scroll bar at 
the bottom left of the screen. Alternatively, if the spreadsheet for 
the document is open on screen (see Chapter 9), selection can be 
made by clicking on the molecule label at the left of the spreadsheet. 
Clicking on  at the bottom left of the screen animates the display of 
molecules in the document, that is, steps through them sequentially. 
This is useful for displaying a progression of graphical surfaces 
along a reaction coordinate. Clicking on  (that replaces ) stops 



Chapter 2	 11

the animation. Animation speed is controlled from the Settings 
Preferences dialog (see Chapter 10).

Two or more molecules from the same document may be displayed at 
once (although only one may be selected). Molecules are marked for 
display by checking the box immediately to the left of the molecule 
label in the spreadsheet (Chapter 9).

Dialogs

Dialogs indicated by ... following their reference in a menu are modal 
and must be dismissed before program operation can continue. All 
other dialogs may be kept open on screen, and different dialogs 
and/or several copies of the same dialog (each copy referring to a 
different molecule in a document or different documents) may be 
simultaneously open on screen.

Database

Included with Spartan Student is a small (~5,000 molecule) subset of 
the Spartan Spectra and Properties Database (SSPD).* This provides 
infrared and NMR spectra in addition to a variety of molecular 
properties obtained from the EDF2/6-31G* density functional 
model. More limited results for a wider range of quantum chemical 
models may be retrieved from an equally small subset of the Spartan 
Molecular Database (SMD). The SSPD and (optionally) SMD subsets 
may be accessed either by molecule name (see Chapter 3) or by 
molecule structure (see below). 

The existence of the selected molecule in the database is signaled by 
its name being displayed at the bottom of the screen.

Details are provided by clicking on  to the immediate left of the 
molecule name (it then changes to ). This brings up a dialog that 
comprises a viewing window on the left and the quantum chemical 
model(s) for which database entries exist on the left (only the EDF2/ 

*	 The SSPD is a growing collection of >110,000 organic molecules along with associated 
properties and 1R and NMR spectra data. Contact sales@wavefun.com for licensing options.
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6-31G* model will appear unless the SMD subset is installed).

The 3D model may be rotated, translated and scaled using the usual 
mouse/keyboard commands (you need to position the cursor inside 
the viewing area). The model may be made to tumble automatically 
by checking the box to the left of Replace All at the bottom of the 
dialog. Model style may not be changed. Where the SMD subset 
is installed, a different database entry (corresponding to a different 
quantum chemical model) may be selected by checking the box to 
the left of the name of the quantum chemical model in the dialog.

The selected (on-screen) molecule may be replaced by the selected 
database entry by clicking on Replace at the bottom of the dialog. 
(Replacement can be undone by selecting Undo from the Edit menu; 
Chapter 4). Note that replacement overwrites all information except 
the molecule identifier (leftmost column of the spreadsheet)associated 
with the molecule being replaced. If desired, the molecule identifier 
can be changed to the molecule name by bringing up a spreadsheet 
(Spreadsheet under the Display menu; Chapter 9), and first left 
clicking to select, then right clicking inside the cell corresponding to 
the leftmost column and selecting Rename Selected Using SSPD 
from the menu that results.

In the event that the selected (on-screen) molecule belongs to a 
multi-molecule document, it is possible to replace all molecules 
in the document for which database entries for the specified level 
of calculation are available. This is accomplished by clicking on 
Replace All instead of Replace. A warning message is provided 
prior to replacement. Molecules in the document for which there 
are no database entries at the specified level of calculation are not 
affected. As with single molecule replacement, all information 
except the molecule identifier is replaced by that in the database. 
Molecule names from SSPD for all molecules in a document may be 
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substituted for the original molecule identifiers by first left clicking 
to select, then right clicking on the header cell of the leftmost column 
in the spreadsheet and selecting Replaced Selected Using SSPD 
from the menu that results.

Stereo Displays
Spartan Student supports red-cyan stereo. Red/blue glasses must be 
worn. To enter stereo mode, press the 3 key. Press again to return to 
non-stereo mode.

Changing Colors and Setting Preferences

Colors and Preferences... under the Options menu (Chapter 10) 
allow for changing default background and graphical object colors, 
and for setting (and resetting) program defaults, respectively.

Monitoring and Terminating Jobs

Monitor under the Options menu (Chapter 10) allows for monitoring 
of executing jobs as well as for terminating jobs.
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Chapter 3
The File Menu

Operations under the File menu access model kits to build and edit 
molecules, and the file system to read and write both native and 
non-native files, import structures according to names contained 
in Spartan’s internal database and the on-line National Cancer 
Institute CACTUS database, import protein structures from the 
on-line Protein Data Bank, print text and on-screen graphics, and 
create QuickTime movies.

New ( )

Brings up a model kit and clears the screen. Model kits are discussed 
in Chapter 7.

Open... ( )

Opens a file that contains all information associated with a particular 
molecule (or list of molecules). In addition to native (.spartan 
and .spardir) files (documents), supported are files containing 2D 
drawings, 3D structures and 1D strings. Also supported are formats 
for experimental IR and NMR spectra. Non-native files are normally 
hidden from view, but may be seen by selecting All Files from the 
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Files of type (All TEXT Files from the Enable menu for Mac) 
menu at the bottom of the dialog.

Close ( )

Closes the document containing the selected molecule, as well as the 
spreadsheet, graphics, plots, spectra and document specific dialogs. 
If the document has not previously been saved, a name is requested. 
If a previously-saved document has been altered, verification that 
the changes are to be saved is requested.

Save ( )/ Save As... ( )/Save Image As...

Saves the document containing the selected molecule exactly as it 
appears on screen. Opening the document will bring it on screen 
exactly as it was last saved. If the document has not previously 
been named, Save behaves as Save As.... Documents may be either 
be saved in native format or in one of several alternative formats. 
Support is also provided for writing QuickTime (movie) files (see 
discussion later in this chapter). Selection is made under the Save 
as type (Format for Mac) menu in the Save As dialog. Save Image 
As... Allows for saving molecules as JPG, PNG, or BMP files as 
well as specifying resolution.

New Molecule

Brings up a model kit and clears the screen. This differs from New, 
in that the resulting molecule is appended to the end of the list 
associated with the molecule that is presently selected. Model kits 
are discussed in Chapter 7.

Delete Molecule

Deletes the selected molecule(s) from a document. Deleting of the 
last molecule in the document leads to an empty document.

Append Molecule(s)...

Appends one or more documents onto the end of the document that 
contains the selected molecule. Append Molecule(s)... leads to a file 
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browser from which one or more documents need to be selected.*

Access Database By Name...

Included with Spartan Student is an ~5,000 molecule subset of the 
Spartan Spectra and Properties Database (SSPD).** The individual 
entries correspond to calculations from the EDF2/6-31G* density 
model and each includes the structure, gas and (estimated) aqueous 
phase energies, infrared and NMR spectra, as well as a variety of 
molecular, atomic and thermodynamic properties. The wavefunction 
is available allowing graphical surfaces and property maps to be 
computed on-the-fly. Selection brings up a dialog.

A name search is initiated by entering a name (or partial name) 
in the box to the right of By Name: at the bottom of the Access 
Database by Name dialog. The search will return all entries that 

*	 Alternatively, molecules may be appended onto an existing document either by copy/paste 
operations using the clipboard or by dragging from an external window. Both require that 
the spreadsheet associated with the destination document be open on screen.

	 To copy a molecule open on screen onto the clipboard, first select (click on) it, and then 
select Copy from the Edit menu. Alternatively, click on its label in its spreadsheet (in the 
leftmost column), and then select Copy from the Edit menu. The latter permits several 
molecules to be selected (and copied) at once using the Shift and Ctrl keys in the usual 
manner. Once on the clipboard, the molecule or molecules may be moved to the destination 
list by clicking on an empty row header in the spreadsheet (for the destination document), 
and then selecting Paste from the Edit menu.

	 To copy a document from an external window, drag it onto the open spreadsheet (associated 
with the destination document) inside of Spartan Student. Several documents can be 
dragged at once using the Shift and Ctrl keys in the usual manner.

**	 Available, but not installed in Spartan Student is an ~5,000 molecule subset of the Spartan 
Molecular Database (SMD). This provides less information about the individual molecules 
(spectra and thermodynamic properties are absent) but for most molecules at more than 
one theoretical model. This may be installed alongside of the SSPD subset, using the Paths 
Preferences dialog (see Preferences under the Options menu in Chapter 10). Contact 
info@wavefun.com to obtain the SMD (Student subset).
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include whatever text string is entered into this box. For example, 
typing in toluene will not only result in toluene, but also molecules 
like para-toluenesulfonic acid and 4-chloro-2-fluorotoluene.

Following the search, one or more hits may be retrieved by selecting 
them from the hit list and then clicking on Retrieve. Shift and Ctrl 
keys are used in the usual way to select multiple entries from the hit list.

If (and only if) the SMD subset has been installed, it is necessary to 
specify which theoretical models are to be searched. This is done by 
clicking on  to the right of the Search button and checking one or 
more entries in the dialog that results. Click on  to close the dialog.

Access CACTUS...

Spartan Student provides on-line access to molecules contained in 
the National Cancer Institute CACTUS database. Selection gives 
rise to a dialog and request for a name.

If the named molecule exists in CACTUS and if information is 
available regarding its structure, clicking on Open will return the 
structure resulting in display of a ball-and-spoke model. This will 
typically require a few seconds. If the named molecule does not exist 
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in CACTUS (an exact match is required) or if structural information 
is not available, a message will be displayed. Try again with another 
name or click on Cancel to remove the dialog.

Note that structures retrieved from CACTUS have been minimized 
using molecular mechanics, but have not been searched for best 
conformer.

Access PDB...

Spartan Student provides on-line access to the Protein Data Bank 
(PDB)* comprising upwards of 75,000 protein and nucleotide 
structures. Selection gives rise to a dialog and request for a four 
character identification code (PDB Id).

Clicking on Open accesses PDB and returns a structure. In the 
event that the PDB entry contains more than one structure, all will 
be returned. PDB access will typically require a few seconds, after 
which a ribbon model of the biomolecule will appear on screen. Any 
small molecules (ligands) associated with the protein will appear as a 
series of transparent spheres (much like a space-filling model) inside 
the biomolecule. Checking Draw Ramachandran Plot provides a 
Ramachandran (f, y) plot for the protein. This may also be accessed 
from the Model menu (Chapter 5).

Print/Print Output/Print Spreadsheet

Selection leads to a dialog in order to designate a printer, specify 
print layout and number of copies. It also allows printing to a file.

*	 The web address is http://www.pdb.org.
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Spartan Student prints whatever is displayed on screen. Note that it 
may be desirable to change the background color to white (Colors 
under the Options menu; Chapter 10). To print text output, bring 
up and select an output window (Output under the Display menu), 
right click in the Output window and choose Print. To print the 
contents of the spreadsheet, bring up a spreadsheet (Spreadsheet 
under the Display menu), right click in the spreadsheet and choose 
Print. Spectra and plots may be printed from within the Spectra or 
Plot dialogs, respectively, once spectra or plots have been displayed. 
Print Preview and Page Setup are also available.

Start/Stop QuickTime Recording

This allows QuickTime movies to be created. To start making 
a movie, select Start QuickTime Recording. Any motions of 
molecules in the main screen will be captured. Dialogs (including the 
builders) will not be captured. Note the use of tumbling (see Settings 
Preferences under Preferences in the Options menu; Chapter 10) 
in making QuickTime movies. To stop making a movie, select Stop 
QuickTime Recording (which has replaced Start QuickTime 
Recording) and supply a name.

Exit

Clears the screen and closes all open documents. A prompt for a name 
is provided for each document that has not previously been saved.



20	 Chapter 4

Chapter 4
The Edit Menu

Operations under the Edit menu provide for undoing commands, 
copying items to and from the clipboard, finding text and graphics, 
centering molecules on screen and clearing the selected molecule.

Undo

Undoes the last operation from the Build and Edit menus.

Cut, Copy, Paste, Select All

Cut moves the selected item to the clipboard and removes it from 
the document. Copy copies the item to the clipboard. The item 
is unaffected. Paste transfers the contents of the clipboard to the 
selected location. The contents of the clipboard are unaffected. Select 
All selects the entire contents of the output window or spreadsheet.

The following are among the important uses of the clipboard:

(i)	 Transferring on-screen graphics into other applications such 
as Microsoft Word® and PowerPoint®.

(ii)	 Temporary storage of a molecular structure for use in 
molecule building.

(iii)	 Transferring data between a Spartan Student spreadsheet 
and other applications such as Microsoft Excel®.
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(iv)	 Making multi-molecule documents and/or transferring 
molecules between documents.

Cut operations for (i) and (ii) require drawing a selection box. First 
position the cursor slightly above and slightly to the left of the item 
to be transferred. Then, while holding down both buttons, drag the 
mouse to a location slightly below and slightly to the right of the 
item to be transferred. Finally, release both buttons. Copy operations 
for (i) and (ii) also refer to the contents of a selection box if one 
has been drawn, but to the selected molecule if a box has not been 
drawn. Copy operations from a Spartan Student spreadsheet refer 
to all information associated with a molecule if selection is made 
on the header cell of the leftmost column, but only to the selected 
(text) information if selection is made on any other column. Further 
discussions relating to use of the clipboard in molecule building is 
provided in Chapter 7 and for spreadsheet operations involving 
multi-molecule documents in Chapter 9. 

Find..., Find Next

Find locates a text string defined in the Find dialog if an output 
window or a spreadsheet is selected, or a structure sequence defined 
on the clipboard if an on-screen model is selected. Find Next locates 
the next occurrence of a text string or a structure sequence.

Center

Centers on screen all molecules in the document for which the selected 
molecule is a member (only the selected molecule is displayed).

Clear

Clears (deletes) the structure and other information for the selected 
molecule, and brings up a model kit. No information is actually 
removed from the file system until the document is saved.
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Chapter 5
The Model Menu

Structure models available under the Model menu include wire, ball-
and-wire, tube, ball-and-spoke and space-filling (CPK) models, with 
or without hydrogens, with or without hydrogen bonds indicated, 
and with or without atom labels, as well as ribbon displays for 
polypeptides and polynucleotides, with or without labels and with or 
without hydrogen bonds indicated. The menu provides for drawing a 
Ramachandran (f,y) plot from a PDB file of a protein, for configuring 
atom labels to display element name, R/S chirality, mass number, 
charge or chemical shift, and for specifying color coding and display 
style for ribbon labels, as well as turning a variety of other labels on 
and off. Finally, it allows model style to be applied globally (to all 
molecules in a document) and models to be manipulated in concert.

Only one model style Wire, Ball and Wire, Tube, Ball and Spoke, 
Space Filling or Hide) may be selected. The selected model is 
designated by  in front of its entry in the menu. Global Model, 
Coupled, Hydrogens, Labels, Ribbons and Hydrogen Bonds 
operate as toggle switches. A  in front of the entry in the menu 
indicates that it is turned on.
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All structure models, and graphics may be displayed either in orthogonal 
or perspective projections. The latter may be valuable in helping to 
visualize large molecules. Selection is done in the Settings tab of the 
Preferences dialog (Preferences... under the Options menu; Chapter 
10). Both structure models and graphics may be presented in 3D stereo. 
This is also controlled from the Preferences dialog as well as by toggling 
on or off the 3 key on the keyboard. Stereographic displays require 
perspective projections. 

Wire

This represents the molecule as a wire model where the vertices 
represent the atoms.

The bonds are drawn in two colors, one for each of the atoms making 
up the bond. Default atom colors are given in Table 5-1.	

Atom colors apply globally (to all atoms of given type), and may 
be changed using the Set Colors dialog (Colors under the Options 
menu; Chapter 10). All models use the same color scheme for atoms, 
and provide for the same mechanism of changing colors.

Ball and Wire 

This represents atoms by small balls and bonds by wires.

The balls are color coded according to atom type, and the wires 
representing bonds are drawn in two colors (as in wire models).

Wire Model

Ball-and-Wire Model



24	 Chapter 5

 main group  	 main group (con’t)

 Hydrogen white	 Indium	 orange
 Lithium orange	 Tin	 gray
 Beryllium green	 Antimony	 orange
 Boron orange	 Tellurium	 orange
 Carbon gray	 Iodine	 violet
 Nitrogen blue-gray	
 Oxygen red	
 Fluorine pale yellow	
 Sodium yellow			 
 Magnesium purple	
 Aluminum magenta	
 Silicon gray	
 Phosphorus orange	
 Sulfur yellow	
 Chlorine  green	
 Potassium red	
 Calcium red	
 Gallium orange	
 Germanium gray	
 Arsenic dark orange	
 Selenium red orange
 Bromine dark red
 Rubidium red
 Strontium red

Table 5-1: Default Atom Colors

transition metals
Scandium-Zinc green
Yttrium-Cadnium green
Lanthanum-Mercury green

lanthanides
Cerium-Lutetium violet

actinides
Thorium-Lawrencium dark blue

noble gases
Helium dark orange
Neon dark orange
Argon dark orange
Krypton dark orange
Xenon orange
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Tube

This is similar to the wire model, except that tubes instead of wires 
are used to represent bonds.

Tubes are split to represent multiple bonds. As with wire models, 
bonds are drawn in two colors.

Ball and Spoke

This represents atoms by balls (the size and color of which depend 
on atom type), and bonds by spokes.

Spokes are split to represent multiple bonds. Bond (spoke) color is 
gray by default but it may be changed from Colors under the Options 
menu (Chapter 10).  

Space Filling

This represents the molecule as a composite of spheres, the radii 
of which have been chosen to approximate van der Waals contact 
distances.* Also known as CPK models, space-filling models are 
intended to portray overall molecular size and shape.

*	 van der Waals radii may be changed from the VDW Radii tab (Preferences under the 
Options menu; Chapter 10).

Tube Model

Ball-and-Spoke Model
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Volume, surface area and polar surface area* displayed in the Molecule 
Properties dialog (Properties under the Display menu; Chapter 9) 
correspond to a space-filling model.

Hide

This removes the structure model from the screen. This may be 
desirable where its display may lead to unnecessary crowding, for 
example, in proteins where ribbon displays are more appropriate. A 
structure model may be restored by selecting it from the Model menu.

Global Model

If checked (turned on), this signifies that all molecules in a document 
will share attributes. These include presentation of hydrogens, atom 
and other labels, hydrogen bonds and ribbon displays. Global model 
style is controlled from the Molecule tab (Preferences... under the 
Options menu; Chapter 10). Global Model acts in a toggle manner, 
switching between global and local display. Global Model is normally 
on.

Coupled

If checked (turned on), this signifies that all molecules in a document 
selected for simultaneous display will be moved together. Coupled 
is turned on following molecule alignment (see Align under the 
Geometry menu; Chapter 6). Coupled acts in a toggle manner, that 
is, repeated selection couples and decouples the molecules.

*	 Polar surface area (PSA) is defined as the area due to nitrogen and oxygen and any hydrogens 
attached to nitrogen and oxygen. Small PSA typically indicates low solubility in polar media 
and large PSA indicates high solubility.

Space-Filling Model
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Hydrogens

If checked, this signifies that hydrogens are to be included in the 
model. Hydrogens acts in a toggle manner, that is, repeated selection 
turns the display of hydrogens on and off.

Labels

If checked, this signifies that labels associated with atoms, ribbons 
and bonds as well as with other attributes specified in Configure... 
(see discussion later in this chapter) are to be displayed in the model. 
Labels acts in a toggle manner, that is, repeated selection turns display 
of labels on and off. Labels is automatically turned on following 
selection of Apply or OK in the Configure... dialog.

Ribbons

If checked, this signifies that ribbons are to be displayed along with 
the selected model. For proteins, it will generally be advisable to 
remove the structure model from view (Hide from the Model menu). 
Ribbons acts in a toggle manner, that is, repeated selection turns 
display of ribbons on and off. 

Ramachandran Plot

If checked, this draws a Ramachandran plot for a protein input from 
the Protein Data Bank (see Access PDB... under the File menu; 
Chapter 3). Ramachandran Plot acts in a toggle manner, that is, 
repeated selection turns the plot on and off. Note that coloring of 
the points on the plot (red for a-helices, blue for b-sheets, green 
otherwise) is not based on the actual 3D geometry but rather on 
assignments in the PDB file.

Hydrogen Bonds*

If checked, this signifies that hydrogen bonds are to be drawn as part 
of the model. Hydrogen Bonds  acts in a toggle manner, that is, 
repeated selection turns display of hydrogen bonds on and off.
*	 Hydrogen bonds are defined as non-bonded contacts between a nitrogen, oxygen, or fluorine 

and a hydrogen attached to nitrogen, oxygen, or fluorine separated by a distance ranging 
from 1.6 to 2.1Å and making an X–H--Y (X, Y = N, O, F) angle of >120°.
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Configure...

This selects the types of labels attached to atoms and ribbons.

	 Configure Labels

Atom labels may be selected from among the following: Labels, 
a unique element/number combination that may be changed 
from the Atom Properties dialog (Properties under the Display 
menu; Chapter 9), Element, Mass Number, R/S (chirality),  
Electrostatic Charge, Strand: Residue\Label (polypeptides 
and polynucleotides), Exposed Area (of an atom in a space-
filling model) or Chem Shift. In addition, Bond Labels, Point 
Labels, Plane Labels, Constraint Labels, Residue Labels, 
and/or Reaction Labels may be provided. Default settings (for 
a new molecule) are made in the Molecule Preferences dialog 
(Preferences under the Options menu; Chapter 10).
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	 Configure Objects

Clicking on the Objects tab leads to the Configure Objects dialog.

If checked, Constraint and Frozen markers, Points and Planes, 
and Reaction arrows attach to the model. If not checked, these are 
shown only in the respective modes, for example, Frozen markers 
are shown only if Freeze Center is selected.

	 Configure Ribbons

Clicking on the Ribbons tab leads to the Configure Ribbons dialog.
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Ribbon coloring may be selected from among the following: 
Monochrome, By Secondary Structure, By Strand or By 
Residue. Ribbon style may be selected from among the following: 
Ribbons, Beads or Lines.

The Configure dialog is removed from the screen with all 
selections maintained by clicking on OK. Clicking on Cancel 
or on  removes the dialog but selections are lost. Clicking on 
Apply maintains the selections but leaves the Configure dialog on 
screen. Note, that Labels (from the Model menu) will be turned 
on following either clicking on OK or on Apply. 
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Chapter 6
The Geometry Menu

Functions available under the Geometry menu allow querying and 
changing bond lengths, angles and dihedral angles, defining points 
and ligand points and planes, setting geometrical constraints, freezing 
atomic centers and aligning molecules in a list.

Measure Distance ( )
Measure Angle ( ) 
Measure Dihedral ( )

Measure Distance displays the distance (in Ångstroms) between two 
atoms, whether or not they are bonded. Selection results in a message 
at the bottom left of the screen.

Clicking on two atoms displays the distance at the bottom right of 
the screen.

Alternatively, clicking on a bond displays its length.
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Measure Distance may also be used to alter the distance between 
atoms (as long as both are not incorporated into the same ring), by 
altering the contents of the box to the right of Distance (A,B) = or 
Length (A)=, and then pressing the Enter key (return key on Mac). 
The distance (length) may be entered into the spreadsheet by clicking 
on  to the right of its display (see Spreadsheet under the Display 
menu; Chapter 9).
Angle and dihedral angle queries are handled in a similar manner. 
Angles require that three atoms or two bonds be identified in the 
proper order while dihedral angles require that four atoms or three 
bonds be identified in the proper order.

Freeze Center ( )

This allows one or more atoms to be held in place during minimization 
(in the builder) and during equilibrium or transition-state geometry 
optimization or energy profile generation (for submitted jobs). 

Atom freezing may be useful in a number of situations, among them 
building a guess for a transition state for a reaction that is closely 
related to one for which a transition state is available. For example, a 
good guess at the transition state for pyrolysis of cyclohexyl formate 
will be obtained by modifying the transition state for pyrolysis of 
ethyl formate, freezing all but the modified sections (designated in 
bold in the figure below) and then minimizing.

H2C CH2
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OC

O

HC CH

H

OC

O

H2C

H2C CH2

CH2

HC CH

H
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H2C

H2C CH2

CH2

H H H

modify
structure

freeze minimize

transition-state structure 
for ethyl formate

approximate 
transition-state
structure for 
cyclohexyl formate

Selection of Freeze Center leads to a message at the bottom left of 
the screen.

Clicking on an atom or free valence*, freezes it; clicking again thaws 

*	 The bond distance in this case is that appropriate for hydrogen being added to the free valence.
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it. Buttons at the bottom right of the screen allow for freezing all 
atoms (Freeze All), freezing all heavy (non-hydrogen) atoms (Freeze 
Heavy) and for thawing all atoms (Thaw All).

Frozen atoms are indicated by magenta colored markers ( ). 

Constrain Distance ( )
Constrain Angle ( )
Constrain Dihedral ( )

These introduce of one or more geometrical constraints during 
structure minimization (in the builder), and during equilibrium or 
transition-state geometry optimization or energy profile generation. 
Constraints may be useful in a number of situations, among them:

(i)	 constructing conformational energy profiles where one or 
more dihedral angles need to be fixed while other geometrical 
variables are optimized,

(ii)	 optimizing molecular structures where the values of certain key 
parameters are known, for example, optimizing the geometry of 
a molecule with an intramolecular hydrogen bond or a disulfide 
linkage, and 

(iii)	 building molecules with unusual geometries, for example, 
molecules with very long bonds, as might be required in the 
construction of transition states and intermolecular complexes.

Selecting Constrain Distance results in a message at the bottom left 
of the screen.

Clicking on two atoms, or a bond results in a message at the bottom 
right of the screen.

Clicking on  changes it to  and shows the current distance.

This (constraint) distance can now be changed by altering the contents 
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of the box and then pressing the Enter key (return key on Mac). 
Alternatively, the existing distance may be used as the constraint 
distance. If the selected distance had previously been constrained, 
the icon  would have been initially displayed. In this case, clicking 
on  turns the constraint off and returns the icon to . Finally, the 
value of the constraint, that may be different from the value of the 
current distance*, may be entered into the spreadsheet by clicking on 

 to its right.

This sequence of operations (bond identification followed by turning 
the constraint on and off) may be repeated as many times as necessary. 
Any bonds or non-bonded distances on which constraints are to be 
imposed are indicated by magenta colored markers. Any constraints 
introduced are automatically enforced only upon energy minimization 
in add fragment mode ( ), but need to be requested  for methods 
under the Calculations dialog (Chapter 8). 

Angle and dihedral angle constraints are handled in a similar manner. 
Note that points and planes may not be used to define constraints.

Locking in a constraint leads to two additional text boxes at the bottom 
right of the screen. This allows a sequence of constraints to be defined 
(from some initial value to some final value in a given number of steps) 
for the purpose of constructing an energy profile along a predefined 
set of coordinates (see discussion under Calculations from the Setup 
menu; Chapter 8).

The leftmost box sets the initial value of the constraint, the middle box 
to the right of to sets the final value, and the rightmost box to the right 
of Steps: sets the number of steps. For example, were the initial value 
set to 0°, the final value to 180° and the number of steps to 10, then a 
series of ten constraints (0°, 20°, 40°, ... 180°) would be specified. This 
can also be accomplished using the Constraint Properties dialog, 
and the value of the constraint posted to the spreadsheet.

*	 Note, however, that it may be problematic to carry out a constrained geometry optimization 
starting from a structure that is very different from that satisfying one or more constraints.
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Whether or not constraint markers are included as part of the model 
(outside of constrain distance, constrain angle or constrain dihedral 
mode) is controlled from the Molecule tab (Preferences... under the 
Options menu; Chapter 10).

Define Point ( )

This defines a point as the geometric (unweighted) center of selected 
atoms (or points) previously defined. Selection results in display of 
a message at the bottom left of the screen.

Clicking on atoms (or points) in any order, and clicking a second 
time on any one of the atoms (or points) defines a point (depicted as 
a small sphere). As many points as desired can be defined and these 
are treated in the same way as an atom in defining distances, angles, 
etc. Points move with the molecule as its geometry is altered.

Selecting Define Point (or clicking on ) while holding down on 
the Shift key, followed by clicking on the appropriate atoms, leads to 
a ligand point. This is a point of attachment directed perpendicular 
to the geometric center of the plane defined by three atoms (or best 
plane in the case of four or more atoms). A ligand point shares all 
the characteristics of a normal point, but may also be used to bond 
to atomic fragments, functional groups, etc. See Make Bond under 
the Build menu (Chapter 7) for a discussion. Ligand points move 
with the molecule as geometry is altered.

Delete from the Build menu ( ) or the Delete key may be used to 
remove a point or ligand point.

Define Plane ( )

This defines and displays a reference plane. Selection results in 
display of a message at the bottom left of the screen.

Clicking on three atoms or points defines a plane. As many planes as 
desired may be defined, and these may be used in defining distances, 
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angles, etc. Planes move with the molecule as its geometry changes.

Delete from the Build menu ( ) or the Delete key may be used to 
remove a plane.

Align ( )

This aligns the selected molecule to all other molecules in the same 
document based on structure. Selection of Align results in a message 
at the bottom left of the screen.

Clicking on an atom designates it as an alignment center, and marks it 
with a red circle. Clicking on the circle removes the designation (and 
the circle). Following selection of alignment centers, clicking on the 
Align button at the bottom right of the screen aligns the molecules. 
If no atoms are selected prior to clicking on Align, then alignment is 
based on all (non-hydrogen) atoms.

Following alignment, two or more molecules may be displayed 
at once using spreadsheet functions (see Spreadsheet under the 
Display menu; Chapter 9). Their motions (coordinates) will be 
coupled following alignment, but may be uncoupled allowing the 
aligned molecules to move independently (see Coupled under the 
Model menu; Chapter 5). Note that alignment center selections are 
kept and molecules can be realigned by again selecting Align from 
the Geometry menu (or clicking on ) followed by clicking on the 
Align button.

The alignment score from 0 to 1 (where 1 designates perfect alignment), 
is available in the spreadsheet. This is accessed by clicking on the 
Add button at the bottom of the spreadsheet, and selecting Alignment 
Score from the list of available properties (see Spreadsheet under 
the Display menu; Chapter 9). A score of 0 is assigned to molecules 
that cannot be aligned to the selected molecule.
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Chapter 7
The Build Menu

The Build menu provides model kits and tools for building and 
editing organic, inorganic and organometallic molecules, as well 
as polypeptides and polynucleotides, and a molecular mechanics 
procedure for structure refinement. This menu also provides seamless 
access to ChemDraw (Windows only) and a facility for guessing 
transition states for reactions based on their similarity to transition 
states in a database of reactions.

Model Kits

Spartan Student provides four different model kits for assembling 
a variety of molecular systems: an organic model kit for most 
organic molecules, an inorganic model kit for organic molecules 
not easily represented in terms of classical valence structures, as 
well as inorganic and organometallic molecules, and model kits for 
polypeptides and polynucleotides. The organic and inorganic model 
kits utilize atomic fragments, functional groups and rings (and ligands 
in the inorganic model kit), while the peptide model kit uses the set 
of natural amino acids as building blocks, and the nucleotide model 
kit the set of nucleotide bases.

Two-dimensional molecular structures (drawings) produced using 
ChemDraw* can also be brought into Spartan Student and converted 
to three-dimensional structures. 
*	 Seamless access to ChemDraw is provided in the Windows version only (via the 2D tab). Both 

Windows and Macintosh versions are able to read ChemDraw files. ChemDraw is not included 
with Spartan Student but is available from CambridgeSoft at http://www.cambridgesoft.com.
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Molecule construction in Spartan Student proceeds much in the 
same manner as a chemist would assemble a structure from a plastic 
model kit, that is, pieces are taken from the kit one at a time and added 
sequentially to the molecule under construction.

Organic Model Kit

The organic model kit contains a suite of molecule building/editing 
tools specifically designed to construct organic molecules.

In the center of the model kit are a selection of atomic fragments, 
which from left to right and then top to bottom, correspond to:

 C(sp3) N(sp3) P(sp3) H
 C(sp2) N(sp2) O(sp3) F
 C(sp) N(sp) O(sp2) Cl
 C(aromatic) N(aromatic) S(sp3) Br
 Si(sp3) N(planar) S(sp2) I

A fragment is chosen by clicking on its icon, which is then displayed 
at the top of the model kit. Once selected, the fragment may be used to 
initiate building, to add alongside of an existing structure or to bond 
to an existing structure. To initiate building, click anywhere on screen. 
To add alongside of an existing structure, first click on the Insert 
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button at the bottom right of the screen or hold down the Insert key 
(option key on Mac) and then click anywhere on screen, or double 
click in a blank area on screen. To bond to an existing structure, click 
on a free valence (not an atom). (Free valences are colored yellow 
on the selected molecule.) Bond type in the case of atomic fragments 
with multiple bond types, for example, sp2 carbon, depends on the 
nature of the free valence selected.

While only H, C, N, O, F, P, S, Cl, Br and I are available from the organic 
model kit, other elements may be substituted using atom replacement 
feature available in the inorganic model kit (see General Molecule 
Building Functionality later in this chapter). Similarly, bond types may 
be altered in the inorganic model kit. Atom and bond types may also 
be altered using the Atom and Bond Properties dialogs, respectively 
(Properties under the Display menu; Chapter 9).

Menus inside the model kit provide access to a number of pre-built 
fragments corresponding to functional groups (Groups) and rings 
(Rings), and to additional libraries of rings (as well as any user-
defined structures) stored in the file system (More). The model kit 
also accesses the clipboard (Clipboard).

	 Groups 

	 Clicking on Groups brings up a menu of groups, and displays an 
icon of one group at the top of the model kit.

	

	 Once selected from the menu, a group may be used to initiate 
building, to add alongside of an existing structure on screen, or 
to add to an existing structure. 
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	 The amide and carboxylic acid/ester groups have more than 
one different free valence. The free valence that is to be used is 
marked with a gold • (in the icon at the top of the model kit). The 
marked position rotates among the possible positions with repeated 
clicking on the icon.

	 Rings

	 Clicking on Rings brings up a menu of hydrocarbon rings, and 
displays an icon of one ring at the top of the model kit.

	
	 Once selected from the menu, a ring may be used to initiate 

building, to add alongside of an existing structure on screen, or 
to add to an existing structure. 

	 Cyclohexane, napthalene, anthracene and phenanthrene have 
more than one different free valence. The one that is to be used 
is marked with a gold • (in the icon). The marked position rotates 
among the available positions with repeated clicking on the icon. 
Selection of an axial or equatorial free valence in cyclohexane 
is indicated by the label ax or eq appearing alongside the icon. 
All rings in this menu are hydrocarbons, but heteroatoms may be 
substituted (see General Molecule Building Functionality later 
in this chapter).

	 More

	 This provides access to a broader selection of rings as well as to 
user-defined entities (normal .spartan files). Upon initial entry, the 
menu to the right of More will be empty. It can be populated, by 
clicking on  to the far right. This brings up a file browser that 
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has been set to point toward a directory containing (among other 
entries) several Spartan Student files of common rings.

		  nitrogen heterocycles	 saturated nitrogen rings
		  oxygen heterocycles	 saturated oxygen rings
		  sulfur heterocycles	 saturated sulfur rings
			   saturated mixed rings

 	 Clicking on a file followed by clicking on Open or double clicking 
on a file fills the menu to the right of More. Menu entries are 
selected in the usual way. In response, a ball-and-wire model of the 
selected ring will appear at the top of the model kit. This may be 
manipulated (rotated, translated, zoomed) using the usual mouse/
keyboard commands (you need to position the cursor inside the 
box). The ring may be used to initiate building, to add alongside 
of an existing structure, or to add to an existing structure. In the 
latter case, the attachment point (on the ring in the window) needs 
to be identified by clicking on the appropriate free valence. 

	 Clipboard

	 Clicking on Clipboard accesses the clipboard. A ball-and-wire 
model of whatever is on the clipboard is displayed at the top of the 
model kit. This may be manipulated using the usual mouse/keyboard 
commands (you need to position the cursor inside the box). Once 
selected, the molecule may be used to initiate building, to add 
alongside of an existing structure, or to add to an existing structure. 
In the latter case, the attachment point needs to be identified 
by clicking on the appropriate free valence in the clipboard.

	 An empty clipboard will be signaled by:

	



42	 Chapter 7

Inorganic Model Kit

Spartan Student’s inorganic model kit allows construction of a much 
wider class of molecules (including inorganic and organometallic 
species) than possible with the organic model kit. Structures that 
violate conventional bonding rules may be constructed, as this model 
kit purposefully provides no checking. The inorganic model kit is 
reached by clicking on the Inorganic tab, located at the top of the 
organic (peptide, nucleotide or 2D) model kit. (Return to the organic, 
peptide or nucleotide model kit, or to ChemDraw is accomplished 
by clicking on the Organic, Peptide, Nucleotide, or 2D (Windows 
only) tab, respectively, from the inorganic model kit).

  

Atoms may be selected by clicking on the center atom button. This 
leads to a full Periodic Table. Main-group elements are colored orange, 
transition metals are colored green and lanthanides and actinides are 
colored blue. The Model menu inside the Periodic Table contains 
the theoretical models supported in Spartan Student.* 

*	 More precisely, except for MMFF and PM3, it lists the elements that are supported with the 
basis sets used by the Hartree-Fock, B3LYP, EDF2 and MP2 models.
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Selecting an entry from this menu leads to recoloring of the Periodic 
Table. A light green color is used to indicate elements for which the 
selected model may be used.* Immediately below is a selection of 
atomic hybrids. Following this is a selection of bond types. Groups, 
Rings, More and Clipboard are the same as in the organic model 
kit; Ligands is new to the inorganic model kit.

Selection of atom type is effected by clicking on the appropriate 
element in the Periodic Table. The entry will be highlighted. Selection 
of an atomic hybrid follows by clicking on the appropriate icon which 
will then be highlighted.** This combination (atom type + atomic 
hybrid) may be used to initiate building, to add alongside of an existing 
structure or to append onto an existing molecular fragment. To initiate 
building, click anywhere on screen. To add alongside of an existing 
structure, first click on Insert at the bottom right of the screen or 
press the Insert key (option key on Mac), and then click anywhere 
on screen, or double click in a blank area on screen. To bond to an 
existing fragment, click on the appropriate free valence.

Two of the hybrids (trigonal bipyramidal and square-based pyramidal) 
may bond either axially or equatorially. Selection of the appropriate 
bonding point, marked by a •, is effected by repeatedly clicking on 
the icon; the bonding point alternates between the two sites.

Atoms are connected with whatever bond type (partial single, single, 
aromatic, double, triple or quadruple) is selected in the model kit. A 
bond type may be changed by first selecting a type and then double 
clicking on the bond. Bond types have no impact on quantum chemical 
calculations, but do affect molecular mechanics calculations (including 
energy minimization in the builder; see discussion later in this chapter).

*	 While molecular mechanics models are available for all elements, they have been carefully 
parameterized for only a relatively few of these.

**	 Additional hybrids for high-coordination centers are available as a library accessible from 
More (see discussion under organic model kit).
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No valence checking is performed in the inorganic model kit, and the 
user is free to construct any arrangement of atoms.

Ligands
This provides access to a number of pre-built ligands, useful in the 
construction of inorganic and organometallic molecules. Its operation 
is analogous to that for the Groups and Rings menus. Clicking on 
Ligands brings up a menu of available ligands, and results in an 
icon of one ligand from this menu being displayed at the top of the 
model kit.

A ligand may be used to initiate building or to add alongside or to an 
existing structure. Additional ligands are accessible from More (see 
previous discussion). Ligands may also be built with the aid of ligand 
points (Define Point in the Geometry menu; Chapter 6).

Peptide Model Kit

A model kit for construction of polypeptides is reached by clicking 
on the Peptide tab located at the top of the organic, inorganic, 
nucleotide and 2D model kits. (Return to the organic, inorganic or 
nucleotide model kit, or to ChemDraw is accomplished by clicking 
on the Organic, Inorganic, Nucleotide, or 2D (Windows only) tab, 
respectively, from the peptide model kit.)
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At the middle of the peptide model kit are icons designating the 
amino acids (specified by their usual three-letter codes). An amino 
acid is selected by clicking on its three-letter code, following which 
either an icon of the amino acid is displayed in the box at the top of 
the model kit, or the three-letter code for the amino acid is appended 
to the sequence of codes in the box. Amino acids replace atoms, 
functional groups, rings and ligands as the building blocks in the 
peptide model kit. Because these other building blocks are missing, 
modifications of  peptides, aside from modifications in sequence and 
in overall conformation, need to be carried out using the organic or 
inorganic model kits.

There are two different modes of operation: single amino acid mode 
and polypeptide mode. The former is used to initiate building with a 
single amino acid, to add a single amino acid alongside of an existing 
structure or to add a single amino acid to an existing structure, while 
the latter is used to construct amino acid sequences (polypeptides).  
Sequence off (unchecked) corresponds to single amino acid mode, 
and on (checked) corresponds to polypeptide mode.

Peptide construction (Sequence on) is accomplished in three steps:
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	 Specification of Amino Acid Sequence

	 This is accomplished by clicking in the desired order on the 
amino acid codes. Building occurs from the N end to the C 
end of the peptide. In response to each selection, the three-
letter code is appended to the sequence of codes in the box 
at the top of the model kit. The stereochemical configuration 
of the amino acid is by default the L configuration; this may 
be changed to the D configuration prior to selection of the 
amino acid, by checking D to the right of stereoisomer in the 
model kit. (It may be changed back to L by checking L). D 
amino acids are indicated by .d following the code in the box.

	 The sequence may be altered by changing the text in the box. 
Existing amino acid codes may be deleted or changed or new codes 
can be added. The entire sequence may be specified in this way 
if desired. Specification of a non-existent code will result in an 
error message. The sequence can be cleared by clicking on Clear.

	 Specification of Macroscopic Structure

	 Once sequencing is complete, macroscopic structure (ψ and φ 
angles), is specified by clicking on α Helix, β Sheet or Other. 
In the case of the first two, preset angle values are displayed on 
the right. In the case of specification of Other, boxes appear, into 
which the desired dihedral angles need to be entered.

	 Termination

	 The peptide is not yet terminated, and the two ends are still set up 
for addition of further amino acids.

	

O
C

*
C end

N
H

*
N end

	 where the * indicates a free valence. Clicking on Terminate at 
the bottom of the model kit leads to the Terminate dialog.
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	 C and N terminating groups may be selected by repeated clicking 

on the C and N icons, respectively. Selection will toggle between 
neutral and charged terminating groups. Clicking on OK removes 
the dialog and terminates the polypeptide. Clicking on Cancel or 

 removes the dialog but does not terminate the polypeptide.

The peptide (or single amino acid) may now be used either to initiate 
building, by clicking anywhere on screen or added alongside of an 
existing structure, by first clicking on Insert at the bottom right of 
the screen or pressing the Insert key (option key on Mac), followed 
by clicking anywhere on screen, or double clicking in a blank area 
on screen. If unterminated, it may also be joined onto an existing 
structure by clicking on a free valence. In the latter case, attachment 
is made from the N end, unless the free valence corresponds to an 
unterminated peptide fragment, in which case the appropriate end 
required to make an amide bond is used.

Nucleotide Model Kit

Spartan Student provides a model kit for construction of 
polynucleotides. It is reached by clicking on the Nucleotide tab 
which is located at the top of the organic, inorganic, peptide and 
2D model kits. (Return to the organic, inorganic or peptide model 
kit, or to ChemDraw is accomplished by clicking on the Organic, 
Inorganic, Peptide, or 2D (Windows only) tab, respectively, from 
the nucleotide model kit.)
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At the middle of the model kit is a menu designating the type of 
polynucleotide.
   		  DNA
   		  DNA (single strand)
   		  DNA-RNA
   		  RNA
   		  RNA (double strand)
   		  RNA-DNA

Immediately below this menu are icons, designating the nucleotide 
bases. Selection of DNA, DNA (single strand) or DNA-RNA from 
the menu leads to one set of icons.

Selection of RNA, RNA (double strand) or RNA-DNA leads to a 
second set, the only difference is that uracil (U) is substituted for 
thymine (T).

A nucleotide base is selected by clicking on its letter, following 
which either an icon of the base is displayed in the box at the top of 
the model kit, or the letter for the base is appended to the sequence 
of letters in the box. Nucleotide bases replace atomic fragments, 
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functional groups, rings and ligands as the building blocks in the 
nucleotide model kit. Because these other building blocks are missing, 
modifications of nucleotides, aside from modifications in sequence 
and helical structure, need to be carried out using either the organic 
or inorganic model kits.

There are two different modes of operation: single base mode and 
polynucleotide mode. The former is used to place a single base or base 
pair on screen, to add a single base or base pair alongside of an existing 
structure, or to add a single base or base pair to an existing structure, 
while the latter is used to construct strands of DNA or RNA (or mixed 
strands). Sequence off (unchecked) corresponds to single base (base 
pair) mode and on (checked) corresponds to polynucleotide mode.

Polynucleotide construction (Sequence on) is accomplished in two 
steps:

	 Specification of Base Sequence 

	 This is accomplished by clicking in order on the base codes. In 
response to each selection, the letter code is appended to the 
sequence of codes in the box at the top of the model kit. The 
sequence may be altered by editing the contents of the box. 
Existing base codes may be deleted or changed or new codes 
added. The entire sequence can be specified in this way if desired. 
The sequence may be cleared by clicking on Clear.

	 Specification of Helical Structure 

	 Once sequencing is complete, a helical structure may be specified 
by clicking on A or B. These correspond to A and B helices, 
respectively. Selecting Other allows user modification of  the 
rise (in Å) per base (Rise/Base) and twist (in degrees) per base 
(Twist/Base).

Note that the polynucleotide is not yet terminated, and the two ends 
are still set up for addition of further bases or base pairs.
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O

O

CH2OPO2

*

Base *

* indicates a free valence. Hydrogens occupy all free valences (except 
the *’ed positions at the two ends of the chain). 

The polynucleotide (or single base pair) may now be used to either 
initiate building, by clicking anywhere on screen, added alongside of 
an existing structure, by first clicking on Insert at the bottom right of 
the screen or pressing the Insert key (option key on Mac) followed 
by clicking on screen, or double clicking on a blank area on screen, 
or joined onto an existing structure by clicking on a free valence. In 
the latter case, attachment is made from the phosphate end.

Accessing ChemDraw (Windows only)*

The ChemDraw program may be seamlessly accessed from inside 
Spartan Student** allowing chemical drawings to be produced in a 
familiar environment and then brought over as 3D structures***. The 
conversion is unambiguous as long as all stereochemical cues are in 
place in the 2D drawing. Note that the conformation implied by the 
2D drawing may be ambiguous and may need to be altered. 

To access ChemDraw, enter the builder, click on the 2D tab and click 
on Edit at the bottom of the panel that results. ChemDraw will appear. 
To return to Spartan Student, close ChemDraw. The 2D drawing will 
appear at the center of the panel and manipulatable 3D structure will 
appear at the top of the panel. Clicking on screen will move the 3D 
structure into Spartan Student’s main window.

*	 ChemDraw files (.cdx) may be read with both Windows and Macintosh versions of Spartan 
Student.

**	 ChemDraw is not provided with Spartan Student but is available from CambridgeSoft at  
http://www.cambridgesoft.com.

***	Transfer is one directional only. 3D structures that have been altered may not be transferred 
back to ChemDraw.
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General Molecule Building Functionality

Additional capabilities are available with Add Fragment selected:

Multiple Fragments

Multiple fragments may result either from bond breakage (see 
Break Bond later in this chapter) or from use of the Insert 
button or Insert key (option key on Mac), or double clicking in 
a blank area on screen. A fragment is selected by clicking on it, 
following which the associated free valences are colored gold (free 
valences for any non-selected fragments are colored white). All 
builder functions apply to the selected fragment only. Rotation 
and translation also apply to the entire set of fragment, but may 
be made to apply to the selected fragment by holding down the 
Ctrl key while carrying out these operations.

Fragments may be attached using Make Bond (see discussion 
later in this chapter).

Bond Rotation/Bond Stretching

In addition to molecule rotation, translation and scaling, the mouse 
is used to rotate about and stretch bonds not incorporated in rings. 
This is accomplished via the following sequence of operations:

(i)	 Clicking on the bond, which is then marked by a red 
cylindrical arrow. (The bond connecting the last atom, group 
or ring added to the molecule is automatically selected.)

(ii)	 Simultaneously holding down the Alt key (option key on 
Mac) and the left mouse button while dragging the mouse 
up and down, for bond rotation, or the Alt (option) key and 
the right mouse button for bond stretching.

Atom/Fragment Replacement

Another function of the mouse is atom replacement. Double 
clicking on an atom (not a free valence) while an atomic fragment 
in the organic model is highlighted, replaces the atom by selected 
fragment. Free valences are adjusted to accommodate the 
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replacement, for example, replacement of sp3 carbon by sp3 oxygen 
results in two free valences being removed. Atom replacements 
that violate valence rules are not permitted. Double clicking on an 
atom (not a free valence) while an element in the Periodic Table 
from the inorganic model kit is selected, replaces the atom by the 
selected element. The latter merely changes the atomic number. No 
changes in the number or arrangement of free valences is made, 
and no checking is done. Atom replacement is not available in the 
peptide and nucleotide model kits.

Chirality Inversion

In the Add Fragment mode, double clicking on a  chiral atom 
while pressing the Ctrl key ( key on Mac) inverts the chirality 
of the atom (R→S or S→R). This is not available in fused ring 
systems. Double clicking on any atom while pressing both Ctrl 
( key on Mac) and Shift keys inverts the absolute configuration 
of the molecule.

Building/Editing Menu Functions

Molecule building/editing functions are found under the Build menu.

View ( )

This exits build mode, and removes the model kit from the screen.

Initial entry into build mode is by way of New or New Molecule under 
the File menu (Chapter 3). Add Fragment, Delete, Make Bond, 
Break Bond and Minimize are for modifying existing structures.

Add Fragment ( )

In addition to the capabilities discussed under General Molecule 
Building Functionality, this allows access to the libraries of 
atomic fragments, groups, rings and ligands, as well as the file 
system and the clipboard. Clicking on any buttons or menus in 
the organic, inorganic, peptide or nucleotide model kits, leads to 
Add Fragment. (If a model kit is not on screen, selection brings 
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up the last-accessed model kit.) A fragment may be used to initiate 
building by clicking anywhere on screen, to add alongside an 
existing structure on screen by clicking on the Insert button at the 
bottom right of the screen or pressing the Insert key (option key 
on Mac) followed by clicking anywhere on screen, or by double 
clicking in a blank area on screen, or be added to an existing 
structure by clicking on the appropriate free valence. Fragment 
addition can be terminated by selection of any other function.

Delete ( )
This allows atom or free valence removal from a structure. Selection 
leads to a message at the bottom left of the screen.

Subsequent clicking on an atom or free valence results in its 
deletion. Deletion of an atom results in deletion of all of its 
associated free valences. Free valences for any atoms to which 
the deleted atom was previously connected are restored. Note 
that atom deletion may result in one or more detached fragments. 
Clicking inside a selection box results in deletion of everything 
inside the box. Selection of Delete does not bring up a model kit 
nor does it remove a model kit that is present on screen. Delete 
may be terminated by selection of any other function.

Delete may also be used to delete points, planes, constraints, and 
frozen atom markers.

Deletion may also be accomplished by holding down on the Delete 
key while clicking on the item to be deleted.

Make Bond ( )
This allows bonds to be drawn between free valences and/or atoms 
on different centers. Selection leads to a message at the bottom 
left of the screen.
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Clicking on two free valences (on different atoms) will cause 
these atoms to be linked by a single bond. Alternatively, double 
clicking on each of two atoms will bond them, and clicking on a 
free valence on one atom and double clicking on a different atom 
will bond the two atoms. Note that available free valences are 
consumed as a result of bond formation, irrespective of whether 
free valences or atoms are selected.* If the selected atoms are 
already bonded, this will result in the bond order being increased 
by one, that is, single → double, double → triple. Selection of 
Make Bond does not bring up a model kit nor does it remove a 
model kit that is already present on screen. Make Bond may be 
terminated by selection of any other function.

Break Bond ( )
This allows breaking an existing bond resulting in free valences. 
Selection leads to a message at the bottom left of the screen.

Clicking on a bond breaks it and restores free valences. Note that 
bond breaking may result in detached fragments. Selection of 
Break Bond does not bring up a model kit nor does it remove a 
model kit that is present on screen. Break Bond may be terminated 
by selection of any other function. 

Minimize ( )

This uses the molecular mechanics model to refine the geometry of 
a molecule or system. Selection leads to a message at the bottom 
left of the screen.

The molecular mechanics energy in kJ/mol, displayed at the 
bottom right of the screen, is continually updated during the 
minimization process. Minimization may be stopped at any time 
by clicking on the  icon at the bottom right of the screen. Any 

*	 Free valences can be protected without altering the geometry of the molecule by adding 
hydrogens to them (  from the organic model kit).



Chapter 7	 55

geometrical constraints imposed on the structure (see Constrain 
Distance, Constrain Angle, Constrain Dihedral in Chapter 6) 
are enforced during minimization. Also, any frozen atoms in the 
structure (see Freeze Center under the Geometry menu; Chapter 
6) remain frozen. 
Following completion, Minimize reverts back to Add Fragment 
only if a model kit is on screen.

Guess Transition State ( )

Spartan Student provides a facility for automatically guessing 
the geometries of transition states based on the similarity of the 
reaction of interest with one or more entries in Spartan Student’s 
reaction database. Where an exact match is not available, Spartan 
Student will attempt to provide as close a match as possible. This 
will generally involve a less substituted system or one in which 
substituents differ. Here, the procedure is to use those parts of the 
structure of the transition state in the database that are common, and 
to optimize the remaining parts (using molecular mechanics).

It may be essential for the reactants to be properly oriented to reflect the 
desired stereochemical outcome of the reaction.

Where a reaction is completely unknown to the database, a fallback 
technique similar to the linear synchronous transit method is 
automatically invoked.

Input to Spartan Student’s transition-state guessing procedure will 
be very familiar to (organic) chemists, in that it is based on reaction 
arrows. The difference is that arrows are superimposed onto a three-
dimensional structure rather than a two-dimensional drawing. The 
reaction is specified using curved arrows, where each arrow identifies 
the movement of one electron pair. The direction of electron flow 
follows customary practice:

source of 
electron pair

destination of
electron pair
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There are two possible sources of an electron pair and three possible 
destinations, leading to six combinations:
lone pair → lone pair	 move lone pair
lone pair → bond	 use lone pair to increase bond order
lone pair → space between atoms	 use lone pair to make a new (single) 

bond
bond → lone pair	 decrease bond order to make lone 

pair
bond → bond	 decrease bond order of one bond to 

increase bond order of another bond
bond → space between atoms	 decrease bond order to make a new 

(single) bond
The first of these is a null operation, and its inclusion has no effect.

Selecting Guess Transition State results in a message at the bottom 
left of the screen.

The tail of the arrow corresponds to the source of the electron pair. If 
the source is a lone pair, then select the atom that holds the lone pair. 
If the source is a bond, then select the bond. Clicking on an atom or 
bond highlights (colors gold) the atom or bond and leads to a new 
message at the bottom left of the screen.

The head of the arrow corresponds to the destination of the electron 
pair. If the destination is an atom (leading to a lone pair), then select 
the atom that will hold the lone pair. If the destination is an existing 
bond (leading to an increase in bond order from single → double → 
or double → triple), then select the bond. If no bond presently exists, 
press the Shift key and select the two atoms that will become bonded 
upon reaction. These operations result in a curved arrow being drawn 
on the reactant structure. This extends from an atom, or the center of 
a bond to an atom, or the center of a bond, or the center of a dotted 
line that has been drawn between atoms that are to be bonded. The 
original message returns to the bottom left of the screen.
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The process (tail selection followed by head selection) is repeated  
as necessary to fully define the reaction. Incorrect reaction arrows may 
be removed by selecting Delete from the Build menu ( ) followed 
by clicking on the arrow to be deleted. It is necessary to again select 
Guess Transition State ( ) in order to continue arrow specification. 
Alternatively, click on the arrow(s) to be deleted while holding down 
the Delete key on the keyboard.

After all reaction arrows have been properly designated, click on  
at the bottom right of the screen to replace the reactant with a guess 
at the transition state. In the event that the guess is unreasonable, this 
operation may be undone (select Undo from the Edit menu). This 
allows you to review your assignment of arrows and make changes 
as needed.

Examples

Diels-Alder reaction of 1,3-butadiene and ethylene

c

a

b

a, b.	double bond to empty space leading to a single bond and to 
a new single bond

c.	 double bond to single bond leading to a single bond and a 
double bond

SN2 reaction of chloride and methyl iodide
a b

C I Cl C l–Cl–

a.	 atom to empty space leading to a new single bond 
b.	 single bond to an atom leading to the loss of the single bond
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Ene reaction of 1-pentene
a
H H

+
cb

a.	 single bond to empty space leading to loss of the single bond 
and to a new single bond

b.	 double bond to single bond leading to a single bond and a 
double bond

c.	 single bond to single bond leading to loss of the single bond 
and to a double bond

Ring closure of 1-hexenyl radical to methylcyclopentyl radical
b

a
•

•

a.	 atom to empty space leading to a new single bond
b.	 double bond to an atom leading to a single bond
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Chapter 8
The Setup Menu

This chapter describes functions available under the Setup menu. 
Calculations is used to specify MMFF molecular mechanics 
calculations, PM3 semi-empirical molecular orbital calculations, 
Hartree-Fock molecular orbital calculations, B3LYP and EDF2 
density functional calculations and MP2 calculations. Tasks include 
calculation of energy, equilibrium geometry, equilibrium conformation 
and transition-state geometry and constructing energy profiles. STO-
3G, 3-21G, 6-31G* and 6-311+G** basis sets are provided for 
Hartree-Fock calculations and 6-31G* and 6-311+G** basis sets 
for B3LYP, EDF2 and MP2 calculations. Calculations also requests 
IR and NMR spectra, and extended printing.

Surfaces is used to designate graphical surfaces, including electron 
and spin densities, electrostatic potentials, local ionization potentials 
and molecular orbitals, for later display as surfaces, property maps 
and contour plots. Inaccessible regions on electron density surfaces 
and property maps based on these surfaces may be demarked.

Submit is used to initiate calculation.

The Setup menu provides access to dialogs for specifying molecular 
mechanics and quantum chemical calculations, for specifying surfaces 
and property maps and for submitting jobs for calculation.

Calculations...

The MMFF molecular mechanics model, the PM3 semi-empirical 
molecular orbital models, Hartree-Fock molecular orbital models, 
B3LYP and EDF2 density functional models and the MP2 Møller-
Plesset models are available to calculate energy, equilibrium geometry 
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and make energy profiles. All models except MMFF are available 
for calculating transition state geometry. Only the MMFF molecular 
mechanics model is available to calculate equilibrium conformation. 
STO-3G, 3-21G, 6-31G* and 6-311+G** basis sets are available for 
Hartree-Fock calculations and 6-31G* and 6-311+G** basis sets for 
B3LYP, EDF2 and MP2 calculations.

The aqueous solvation energy obtained by the SM5.4 model is added 
to the energy of any molecular mechanics or quantum chemical 
calculation and provided in the Molecule Properties dialog 
(Properties under the Display menu; Chapter 9).

Quantum chemical calculations also provide atomic charges, IR and 
NMR spectra. IR spectra are available for all models but NMR spectra 
are only available for the B3LYP/6-31G* and EDF2/6-31G* models.

Selection of Calculations... results in the Calculations dialog.

This contains pull-down menus, buttons and check boxes:

Calculate

This section is used to specify the task to be accomplished, 
theoretical model to be employed and spectra to be supplied.

Specification of a task is by way of a pull-down menu:

Energy specifies calculation of energy (and in the case of quantum 
chemical methods, a wavefunction) at a single geometry. 
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Spartan Student reports energies from molecular mechanics calculations 
in kJ/mol, from semi-empirical calculations as heats of formation in kJ/
mol, and from Hartree-Fock, B3LYP, EDF2 and MP2 calculations as 
total energies in atomic units (hartrees).

The molecular mechanics energy comprises two parts: the strain energy 
and the non-bonded energy. The strain energy is the difference in energy 
between a molecule and its “strain free” analog. It is nearly always positive 
and less than a few hundred kJ/mols in magnitude. The non-bonded energy 
accounts for attraction or repulsion between atomic centers that are not 
connected due to van der Waals and Coulombic interactions. Because the 
strain energy of every molecule relates to a different standard, molecular 
mechanics energies cannot be used to obtain reaction energies (unless 
there are no changes in bonding between reactants and products).

The heat of formation is to the enthalpy at 298K of a balanced chemical 
reaction in which a molecule is converted to a set of standard products. 
For example, the heat of formation of ethylene is given by reaction,

C2H4 + → 2C (graphite) + 2H2 (gas)

where graphite and hydrogen molecule are the carbon and hydrogen 
standards, respectively. In practice, the actual measurement is typically 
carried out for a combustion reaction, for example, for ethylene:

C2H4 + 3O2 → 2CO2 + 2H2O

Heats of formation may either be positive or negative quantities and 
generally span a range of only a few hundred kJ/mol.

Heats of formation are not suitable for presenting energy data from 
quantum chemical calculations, simply because the standards for several 
important elements (most notably, carbon) are not well-defined isolated 
species. In its place is the energy of a reaction that splits a molecule into 
isolated nuclei and electrons, for example, for ethylene:

C2H4 → 2C+6 + 4H+ + 16e–

Total energies, as the energies of such reactions are termed, are always 
negative and may be very large (tens of thousands of kJ/mol). They are 
most commonly given in atomic units (hartrees).

1 atomic unit = 2625 kJ/mol

It is possible to relate total energies to heats of formation by incorporating 
data on atomic species. Heats of formation reported from T1 calculations 
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(part of the information provided in Spartan Student’s database) relate 
directly to experimental heats and are given in kJ/mol.

To summarize, the heat of formation differs from the total energy both with 
regard to the standard reaction and with regard to units. Either provides 
a suitable basis for thermochemical calculations.

Equilibrium Geometry specifies that the nearest energy minimum 
will be located, Equilibrium Conformer specifies that the lowest 
energy conformer will be located and Transition State Geometry 
specifies that the nearest transition state (energy maximum in one 
dimension and energy minima in all other dimensions) will be 
located. Energy Profile steps along user-defined coordinates.

Except for Equilibrium Conformer, a theoretical model needs 
to be specified by way of pull-down menus. The first provides a 
choice among different classes of models.

Selection of Molecular Mechanics leads to a single method, 
MMFF. Selection of Semi-Empirical leads to a single method, 
PM3. Selection of Hartree-Fock leads to a second menu of 
available basis sets.

Selection of either B3LYP, EDF2 or MP2 leads to an abbreviated 
menu of available basis sets.

Transition State Geometry is not available for Molecular 
Mechanics and Equilibrium Conformer is only available for 
Molecular Mechanics. 

If checked, Infrared Spectra calculates vibrational frequencies 
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and intensities together with the corresponding vibrational modes. 
These are available in the output (Output under the Display menu; 
Chapter 9) along with zero-point energies and thermodynamic 
properties (enthalpies, entropies, heat capacities and Gibbs 
energies). The thermodynamic properties are also available from 
the Thermodynamics Properties dialog (Properties under 
the Display menu; Chapter 9) as a function of temperature. 
Vibrational motions (normal modes) may be animated and an IR 
spectrum displayed from the IR dialog accessible from Spectra 
under the Display menu (Chapter 9). Frequency calculations 
involving MP2 models are very costly in terms of computation 
and are not recommended.

Infrared frequencies from B3LYP/6-31G* and EDF2/6-31G* 
calculations (only) have been uniformly scaled to account for 
known systematic errors. Calculated frequencies from the other 
available models have been left unscaled. In addition, the lines 
in the calculated infrared spectrum obtained from all models 
have been broadened to account for the fact that the calculations 
correspond to 0K, whereas experimental measurements are carried 
out at finite temperature. Scale and line width parameters may be 
adjusted following display of the spectrum (Spectra under the 
Display menu; Chapter 9).

If checked, NMR Spectra specifies that NMR chemical shifts 
from the B3LYP/6-31G* and EDF2/6-31G* models (only) will be 
calculated. These are then available in the output (Output under the 
Display menu; Chapter 9) as well as from the Atom Properties 
dialog (Display menu) and as atom labels (Configure... under the 
Model menu; Chapter 5). 13C (proton decoupled) and 1H spectra 
may be displayed from the NMR Spectra dialog accessible from 
Spectra under the Display menu (Chapter 9)*. 13C chemical shifts 
(only) that have been empirically corrected for local environment 
are also available in the printed output, as atom labels, from the 
Atom Properties dialog and in spectral plots. Line intensities are 

*	 Chemical shifts for other nuclei are available in the Output dialog (Output under the 
Display menu) and may also be attached as labels (Configure... under the Model menu; 
Chapter 5).
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assumed to be proportional to the number of equivalent carbons or 
hydrogens. Three-bond HH coupling constants for 1H spectra are 
estimated empirically and may be displayed in terms of spectral 
splittings.

Total Charge

Total charge. The default setting (Neutral) may be changed either 
by clicking on , and selecting Anion, Dianion, -3, etc. from the 
menu, or by typing a number in the. Total Charge is ignored for 
molecular mechanics calculations.

Unpaired Electrons

The number of unpaired electrons. The default setting (0) may 
be changed either by clicking on , and selecting 1 or 2 from the 
menu, or by typing in the menu. Unpaired Electrons is ignored 
for molecular mechanics calculations.

Print

If checked, writes the quantity to the output window. Text output 
may be seen by selecting Output from the Display menu (Chapter 
9) and printed by first selecting the output dialog and then selecting 
Print Output from the File menu (Chapter 3).

If checked, Orbitals & Energies writes the orbitals and 
energies to the output. An orbital energy diagram may also be 
displayed (Orbital Energies under the Display menu; Chapter 
9) and HOMO and LUMO energies are also available in the 
spreadsheet (Spreadsheet under the Display menu; Chapter 9).

If checked, Vibrational Modes writes vibrational frequencies 
and modes to the output. This requires that the infrared spectrum 
has been calculated.

If checked, Charges and Bond Orders writes atomic charges 
and bond orders to the output.
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Global Calculations

If checked, signifies that settings in the Calculations dialog are 
to be applied to all molecules in the document.

The Calculations dialog may be exited by clicking on Submit, 
Cancel or OK at the bottom right of the dialog, or on  at 
the top. (Submit and OK are not available if the job is already 
executing.) Clicking on OK or on Submit overwrites any previous 
information. Additionally, Submit enters the job in the execution 
queue (see discussion later this chapter). Clicking on Cancel or on 

 exits the Calculations dialog without saving any changes.

Surfaces

Spartan Student allows graphical display of the HOMO and LUMO 
among other molecular orbitals, the electron density, the spin density 
for molecules with unpaired electrons, the electrostatic potential and 
the local ionization potential.

Additionally, any one of the quantities listed above (except the electron 
density) may be mapped onto any surface (except a molecular orbital 
surface). In practice, the only maps to have received widespread 
attention are those based on the electron density surface (depicting 
overall molecular size and shape). Most common are the electrostatic 
potential map, the local ionization potential map and the LUMO map. 
Some regions of an electron density surface are inaccessible and are not 
available for interaction with their environment (or with an incoming 
reagent). Spartan Student allows these regions to be identified.*

Surfaces (including those underlying maps) connect points of equal 
value (they are isosurfaces), and may be displayed as an arrangement 
of dots, a mesh, or an opaque or translucent solid. Examples of 
graphical output in orthogonal projection are provided in Figure 
8-1. Surfaces (and maps) may also be rendered in perspective (see 
Chapter 5) and in stereo (see Chapter 2).

*	 A region on a density surface is designated as inaccessible if a sphere of radius 1.0 Å 
centered on a line normal to the surface and touching a point in the middle of the region, 
impinges on any other regions of the density surface. The sphere radius may be changed in 
the Settings Preferences dialog (Preferences under the Options menu; Chapter 10).



66	 Chapter 8

showing bonding in the transition state.

showing hydrogen bonding.

showing interaction of the HOMO of 
1,3-butadiene and the LUMO of ethylene. 

showing overall molecular size and shape.

Frontier orbitals for a symmetry-allowed 
Diels-Alder reaction,

Space-filling model and electron density 
surface of cyclohexanone,

Electron density surface (0.08 electrons/
au3) of transition structure for pyrolysis 
of ethyl formate,

Electrostatic potential surfaces (-40 kJ/mol) 
of trimethylamine (left) and dimethyl ether 
(right),

Electron density slice for acetic acid 
dimer,

Figure 8-1: Examples of Graphical Displays Available in Spartan Student

showing accessibility for nucleophilic at-
tack.

Simultaneous display of the LUMO 
and the electron density surfaces of 
cyclohexanone,

showing the lone pairs on nitrogen 
and oxygen, respectively.
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Calculated quantities may also be displayed as two dimensional 
contour plots (slices). Unlike surfaces and maps, these can be 
translated, rotated and zoomed independently of the molecular 
skeleton. An example of a slice display is provided in Figure 8-1.

Several different surfaces, maps and slices may be simultaneously 
displayed. In addition, any of the usual structure models may be 
displayed along with the graphic. The total display can become very 
complex, and selective use of meshes and/or translucent solids (as 
opposed to opaque solids) may facilitate visualization.

Selection of Surfaces leads to the Surfaces dialog.

This contains a box at the top for listing requested surfaces and 
property maps. 

Common Surfaces and Property Maps

Add at the bottom of the dialog is used to specify a number of 
commonly-used graphical surfaces and property maps*. Clicking 
on it leads to a menu.

	
	 Selection of all but the last entry in the menu leads to a request 

for the analogous surface or map. A surface and property map 

*	 Additional selections are provided if the molecule has unpaired electrons.
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specified from this menu will be calculated at medium resolution 
and will assume a fixed isovalue unless a different resolution has 
been selected and/or an adjustable isovalue has been requested. 

More Surfaces
	 Additional surfaces and maps or the same surfaces or maps 

at different resolution and with adjustable isosurfaces may be 
requested by selecting More Surfaces... from the menu (or by 
clicking on More Surfaces... at the bottom of the Surfaces dialog). 
This leads to the Add Surfaces dialog that contains three menus 
and a check box:

Surface  

Available surface types appear under the Surface menu.

	 Density is the total electron density which may be used to reveal 
bonding as well as overall molecular size and shape, HOMO{-}, 
HOMO, LUMO, LUMO{+}, SOMO* are molecular orbitals, 
potential is the electrostatic potential, ionization is the local 
ionization potential and spin* is the spin density.

	 Selection of HOMO{-} and LUMO{+} results in display of a box 
to decrement the HOMO and increment the LUMO. This allows 

*	 These menu entries appear only for molecules with one or more unpaired electrons.
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any molecular orbital to be specified..

	

	 Slice designates that a plane will cut through the graphic defined 
by Property.

	 Property  

	 Properties for maps appear in the Property menu.

	
	 Available properties are the molecular orbitals (HOMO{-}, 

HOMO, LUMO, LUMO{+}, SOMO*), the electrostatic potential 
(potential), the local ionization potential (ionization) and the spin 
density (spin)*. none indicates that no property is to be mapped 
onto the surface). As with Surface above, selection of HOMO{-} 
and LUMO{+} leads to a decrement (increment) box.

	 A Spin button will be displayed if Unpaired Electrons (in 
the Calculations dialog) is set to a value other than 0, and if 
HOMO{-}, HOMO, LUMO or LUMO{+} has been selected 
for Surface or for Property. Clicking on Spin toggles it between 
Alpha and Beta. Alpha designates that the molecular orbital either 
to be displayed as a surface or mapped as a property corresponds 
to α spin; Beta designates that the molecular orbital corresponds 
to β spin.

	 Resolution 

	 Selection of surface resolution is from the Resolution menu.
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High resolution is necessary for surfaces based on percentage 
enclosure. Both calculation time and disk storage increase 
significantly in moving from medium to high resolution.

	 Isovalue 

	 Allows calculation of a surface with fixed isovalue. In the case 
of a density surface, the default value of 0.002 electrons/bohr3 
corresponds roughly to enclosure of 99% of the total number 
of electrons and closely resembles a space-filling model. Fixed 
surfaces take less time to compute and require less storage.

Following Surface, Property, Resolution, Isovalue and (optionally) 
spin selection, clicking on OK adds the requested graphic to the list 
and removes the (Add Surfaces) dialog. Clicking on Apply adds the 
requested graphic to the list but leaves the dialog on screen. Clicking 
on Cancel does not add a graphic to the list but removes the (Add 
Surfaces) dialog.

The process (clicking on Add..., followed by selection from the menu 
or clicking on More Surfaces... followed by selection of surface, 
property, resolution and isovalue and clicking on OK or Apply) may 
be repeated as required.

An existing graphic may be deleted from the list by first highlighting 
(clicking on) it and then clicking on Delete.

Global Surfaces, if checked, signifies that the requested surfaces will 
be calculated for all members of the list.

Only one copy of the Surfaces dialog may appear on screen, and any 
actions relate to the currently selected molecule. The dialog may be 
removed by clicking on .

Submit

Following setup of a molecular mechanics or quantum chemical 
calculation, as well as any requests for properties, spectra and/or 
graphical displays, the required calculations will begin when Submit 
is selected. If the job has not previously been saved or submitted, 
selection of Submit triggers a request for a name. If the document 
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contains only a single molecule and that molecule exists in the Spartan 
Spectra and Properties Database, the name in the database will be 
presented as a default name. Otherwise, the default name presented 
will be spartan for the first job and spartanx (x an integer starting 
with 1 for all successive jobs). After a name has been provided (or 
if a name already exists or if the default name is accepted) a dialog 
appears indicating that the job has actually been submitted.*

Click on OK to remove it. After a job has started, and until it has 
completed, all associated files will be designated read only.

Another dialog appears following completion of a calculation.

Click on OK to remove it.

Upon completion, an energy profile calculation leads to an additional 
document being created for each molecule in the original document. 
These new documents are named document.Prof.identifier where 
document is the name given to the original document and identifier 
identifies the molecule inside the original document. A query dialog 
is provided asking whether the resulting Spartan document is to be 
opened.

*	 The job is submitted to a job queue and will be submitted for execution only when released 
from this queue. See Monitor under the Options menu (Chapter 10) for discussion.
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Chapter 9
The Display Menu

Functions available under the Display menu provide for text, dialog, 
spreadsheet and graphical displays. Functions are also available to 
query a variety of on-screen objects, display both calculated and (if 
available) experimental IR and NMR spectra, animate vibrational 
motions, prepare plots from spreadsheet data and calculate reaction 
energies.

Output

Selection of Output opens a window.

The contents of the output window may be scrolled and may be paged 
up or down by clicking above or below the scroll bar. The contents 
may be printed or copied by right clicking inside the Output window 
and selecting Print or Copy from the menu that results. Alternatively, 
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if Confined has been selected for Output/Spreadsheet Windows 
(from the Preferences menu, Chapter 10), printing is accomplished 
by selecting Print Output... from the File menu (this replaces 
Print... when an output window is selected). Similarly, copying is 
accomplished by selecting Copy from the Edit menu when an output 
is selected. Find... and Find Next functions from the Edit menu are 
also available.

A single output window is associated with each document, and 
changes focus as different molecules from the document are selected. 
Output windows for different documents may be simultaneously open 
on screen. An output window may be closed by clicking on .

Output from jobs that are currently executing or are in the execution 
queue, is unavailable. Output for jobs that are executing may be viewed 
using the Monitor under the Options menu (Chapter 10).

Properties

Spartan Student provides specialized dialogs for reporting and (in 
some cases) changing the properties of molecules, atoms, bonds, 
graphical surfaces and geometrical constraints. Only one Properties 
dialog may be opened at a time. Dialog selection operates in a toggle 
mode. The default Properties dialog is Molecule Properties. Other 
Properties dialogs may be accessed by clicking on an atom, bond, 
surface, or constraint. For example, clicking a second time on an 
atom, bond, or constraint reverts the currently displayed Properties 
dialog back to Molecule Properties.*

Most Properties dialogs have an associated Utilities or Style dialog. 
For example, associated with the Molecule Properties dialog is a 
Molecule Utilities dialog. These access additional information about 
the molecule and its components/attributes, or provide style and color 
controls. This is useful for highlighting (or deemphasizing) a particular 
molecule, component or attribute. Utilities/Style dialogs are reached 

*	 The exception to this involves clicking on a property map to obtain the value of the property 
at a particular surface location. Clicking a second time on a new location will report a new 
value of the property. Clicking on the background leads to the Molecule Properties dialog.
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by clicking on  at the bottom right of the appropriate Properties 
dialog. Return to the Properties dialog follows from clicking on  
at the bottom right of the associated Utilities/Style dialog. 

The Properties (or Utilities/Style) dialog may be removed from the 
screen by clicking on .

	 Molecule Properties and Thermodynamics

	 The Molecular Properties dialog is divided into two displays 
Molecule and Thermodynamics, controlled by tabs at the top 
left. Entries under the Molecule tab relate to common molecular 
properties that (if applicable to the selected level of calculation) 
are automatically calculated. 

Molecule Properties

The dialog under this tab includes the name, formula, CAS 
number, molecular weight (in amu), surface area and polar 
surface area (PSA) of a space-filling model (in Å2), volume of 
a space-filling model (in Å3) and the point group. It provides 
the energy (in au) of a Hartree-Fock, B3LYP, EDF2 or MP2 
calculation, the heat of formation (in kJ/mol) of a PM3 
calculation, or the sum of the strain energy and non-bonded 
energy (in kJ/mol) of an MMFF calculation, the energy (heat of 
formation, strain energy) corrected for an aqueous environment 
(in the same units as the non-corrected quantity), the solvation 
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energy (in kJ/mol) as the difference between aqueous and 
gas-phase energies, (if available) the heat of formation from 
the T1 model (in kJ/mol), (if available and in parenthesis) 
the experimental heat of formation (in kJ/mol) and the dipole 
moment (in debyes). With the exception of experimental 
heat of formation, any or all of these may be posted to the 
spreadsheet using the  buttons to the left of their values. 
Label (also referred to as identifier) identifies the molecule in 
a document. It appears in the first column of the spreadsheet 
(see Spreadsheet later in this chapter) and can be changed to 
the molecule’s name from the Spartan Spectra and Properties 
Database.* Finally, the dialog permits display of the dipole 
moment vector by checking the box to the right of Display 
Dipole Vector.

Thermodynamics
Entries under the Thermodynamics tab provide the zero-point 
energy, the enthalpy, the constant volume heat capacity, the 
entropy and the Gibbs energy. Except for the zero-point energy, 
all depend on temperature which can be specified. All require 
vibrational frequencies.

*	 If the molecule does not appear in the Spartan Spectra and Properties Database, the name 
will be M000X (X=1,2,...) unless altered by the user.
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Atom Properties

Selection of an atom with a Properties dialog on screen, or 
selection of Properties following selection of an atom, leads to 
the Atom Properties dialog.

This displays the element name (and allows changing the element), 
R/S chirality, electrostatic-fit charges (in electrons), calculated 
NMR chemical shift (in ppm relative to the appropriate standard; 
tetramethylsilane for both proton and 13C) and exposed surface 
area of a space-filling model (in Å2). It also allows freezing the 
atom (see Freeze Center in Chapter 6), eliminating the line from 
the displayed NMR spectrum, changing its mass number and the 
default label, and posting atomic charges, chemical shifts and 
exposed areas to the spreadsheet.

Bond Properties

Selection of a bond with a Properties dialog on screen, or selection 
of Properties following selection of a bond leads to the Bond 
Properties dialog (not shown). This displays the bond length (in 
Å), Mulliken bond order (in electrons) and bond type (and allows 
changing the bond type). Note that the results of quantum chemical 
calculations do not depend on bond types.
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Constraint Properties

Selection of a constraint marker with a Properties dialog on 
screen, or selection of Properties following selection of a 
constraint marker, leads to the Constraint Properties dialog 
(expanded form shown).

This allows setting the value of a constraint, posting it to the 
spreadsheet and changing the default constraint label. Checking 
Dynamic leads to the expanded dialog shown above. This allows 
specifying a sequence of constraints for an energy profile (see 
Calculations... under the Setup menu; Chapter 8). The value of 
the starting constraint is given in the box to the right of Value, 
and the value of the ending constraint is given in the box to the 
right of to. The number of steps in the profile is given in the box 
to the right of Steps. Initially, the numbers in both boxes to the 
right of Value will be the same, and Steps will be set to 1. These 
may be altered by typing the desired numbers into the appropriate 
boxes and then pressing the Enter key (return key on Mac). This 
functionality may also be accessed from Constrain Distance 
(Angle, Dihedral) under the Geometry menu (Chapter 16). If 
Global Steps is checked, the independent variables are moved in 
concert, meaning that the number of steps must be the same for 
each variable (the constraint ranges may be different). If unchecked, 
the variables are moved independently and the number of steps 
may differ from one to another. In this case, the total number of 
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steps in the profile is the product of the number of steps for each 
variable. An energy profile may involve constraints on more than 
one geometrical variable.

Point and Plane Properties

Selection of a user-defined point or plane with a Properties 
dialog on screen, or selection of Properties from the Display 
menu following selection of a point or plane, leads to the Point 
Properties or Plane Properties dialog (not shown). These allow 
changing point or plane labels. 

Surface Properties

Selection of a graphical display with a Properties dialog on screen, 
or selection of Properties following selection of a graphical 
display, leads to the Surface Properties dialog.

This allows changing display style, isovalue (and in the case of 
electron density surfaces), percentage of the electrons contained 
inside the surface, turning on mapped properties, selecting 
between continuous and banded displays and setting the range of 
the property, displaying accessible area of surfaces and maps and 
changing the default labels. The dialog also reports (and optionally 
posts to the spreadsheet) the area and volume of the graphic, the 
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accessible area*, the polar area of an electrostatic potential map**, 
maximum and minimum value of the mapped property and its 
value at the cursor position***. If checked, Legend displays a scale. 
If checked, Global Surfaces designates that the settings apply to 
all molecules in the document.
If the selected graphical surface is a slice, the Slice Properties 
dialog replaces the Surface Properties dialog.

This contains similar controls to that found in the previous dialog. 
Specification of isovalue has been replaced by specification of the 
number of contours to be displayed. A sphere or a cylinder may 
be selected instead of a plane, and check boxes allow for a frame 
around the slice and for a grid.

Surfaces

This accesses the same dialog previously described in Chapter 8.

*	 A region on a density surface is designated as inaccessible if a sphere of radius 1.0 Å centered on a 
line normal to the surface and touching a point in the middle of the region, impinges on any other 
regions of the density surface. The default radius (Accessible Area Radius) may be changed 
in the Settings Preferences dialog (Preferences under the Options menu; Chapter 10).

**	 This is defined as that part of the surface area for which the absolute value of the electrostatic 
potential is > 100 kJ/mol. The cutoff (Polar Area Range) may be changed in the Settings 
Preferences dialog (Preferences under the Options menu; Chapter 10).

***	To determine property value at another position click on it. To bring up the Molecule 
Properties dialog, click on the background.
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Spectra ( )

Spartan Student provides for display of calculated IR and NMR 
spectra. (These need to have been previously requested from the 
Calculations dialog under the Setup menu; Chapter 8.) In addition, 
it allows on-line access and display of experimental spectra from 
publicly available collections. This allows direct visual comparison 
of calculated and experimental spectra. Finally, the IR Spectra dialog 
allows fitting of calculated and experimental spectra, using a linear 
scaling parameter and a peak width parameter to adjust the calculated 
spectrum. Access to spectra  display is via tabbed dialogs (IR, Proton 
NMR and 13C NMR).

IR

The IR Spectra dialog not only provides for display of a calculated 
and (if available) experimental infrared spectra, but also allows for 
animated display of the vibrational modes as well as for generation 
of a sequence of structures along a vibrational coordinate.

At the left-hand side of the dialog is an ascending list of frequencies 
(in cm-1)* together with (infrared) intensities and symmetry labels. 

*	 Imaginary frequencies, for example, corresponding to the reaction coordinate for a 
transition state, will appear first in the list with the letter i in front of the frequency value.
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A frequency is selected for display by clicking on it. This results 
in display (animation) of the vibrational motion. Clicking again 
deselects it (stops the animation).

The amplitude of vibrational motion (the maximum displacement 
away from equilibrium of any pair of atoms) may be changed 
from the default amplitude (0.5Å, which is much larger than the 
actual amplitude of vibrational motion at room temperature) by 
altering the contents of the box to the right of Amp at the lower 
right of the dialog. The default number of steps that make up the 
display (11) may be changed by altering the contents of the box 
to the right of Steps* at the lower right of the dialog.

Clicking on Make List creates an unnamed Spartan Student 
document containing a sequence of structures corresponding 
to motion along the selected vibrational mode. Sequences 
(corresponding to different vibrations) can be created.

The calculated spectrum may be drawn by clicking on Draw 
Calculated at the top right of the dialog.

	

The experimental spectrum may be drawn with or without the 
calculated spectrum by clicking on Draw Experimental at the 
center right of the dialog.

*	 It is recommended that the number of steps be odd ensuring that the center point corresponds 
to the actual equilibrium or transition-state structure.
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Experimental IR spectra are accessed from the NIST (National Institute 
of Standards and Technology) website (http://webbook.nist.gov/
chemistry). This comprises approximately 7,000 IR spectra, primarily 
for organic molecules.

Draw operations for both calculated and experimental IR 
spectra, apply to all molecules in the document (not just the 
selected molecule). The range for calculated and experimental 
IR spectra is from 4000 cm-1 to 500 cm-1, corresponding to the 
range commonly measured and reported. 

Calculated IR frequencies exhibit systematic errors. Stretching 
frequencies obtained from Hartree-Fock models are typically 
10-12% larger than measured frequencies, while stretching 
frequencies obtained from B3LYP, EDF2 and MP2 models are 
typically 5-6% larger than measured frequencies. Systematic 
errors may be revealed (and quantified) by first simultaneously 
displaying calculated and experimental spectra and then scaling 
one of the spectra to provide a best visual fit. To scale the calculated 
spectrum, use the slider bar to the right of Scale near the top right 
of the dialog. Scaling applies uniformly to all molecules in a list 
(not just the selected molecule).

A second slider bar marked Temp controls peak width. (This is 
loosely connected with the temperature at which the experimental 
measurement is carried out.) Low “temperature” (slider to the 
left) will produce sharp spikes, whereas high “temperature” 
(slider to the right) will produce broad bands. The default setting 
gives spectra that resemble experimental spectra.
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A best fit of calculated to experimental infrared spectra is obtained 
by clicking on Experimental.

Proton NMR

The Proton NMR Spectra dialog provides for display of both 
calculated and (if available) experimental  1H spectra.*

The calculated proton NMR spectrum may be drawn by clicking 
on Draw Calculated and line splittings due to three-bond HH 
coupling shown by checking Show HH Couplings.** 

	
An experimental proton spectrum may be added to the plot by 
clicking on Draw Experimental. Draw operations apply to all 

*	 Chemical shifts are available only from B3LYP/6-31G* and EDF2/6-31G* calculations. 
Chemical shifts for nuclei other than hydrogen and carbon may be displayed as labels (see 
Configure... under the Model menu; Chapter 5).

**	 Coupling constants are not calculated models but rather are estimated empirically.
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molecules in a list. Spectra may be removed by clicking on Delete 
Calculated and Delete Experimental (that have replaced the 
cooresponding draw buttons). The range for both calculated and 
experimental proton spectra is from 0 ppm to 10 ppm (relative 
to TMS). This  corresponds to the range typically measured and 
reported.

To magnify a region on a plot, position the cursor at one corner of 
the region, drag the mouse to the opposite corner while holding 
down the left button and release the button.

	

13C NMR

The 13C NMR dialog provides for display of both calculated and 
(if available) experimental  13C spectra.
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The calculated 13C spectrum may be drawn by clicking on 
Draw Calculated. 13C NMR spectra will be based on chemical 
shifts that have been empirically corrected to account for local 
environment.

	

The corresponding experimental 13C spectrum (if available) may 
be displayed together with or independently of the calculated 
spectra by clicking on Draw Experimental. 

	

Draw operations for both calculated and experimental NMR 
spectra apply to all molecules in a list. The calculated spectrum 
may be removed by clicking on Delete Calculated (that has 
replaced Draw Calculated) in the appropriate section of the 
dialog. Similarly, the experimental spectrum may be removed by 
clicking on Delete Experimental). The range for both calculated 
and experimental 13C spectra is 0 ppm to 200 ppm (relative to TMS). 
This corresponds to the range typically measured and reported.

Only a single copy of one of the dialogs under Spectra may 
appear on screen; scaling will relate to the currently selected 
molecule. The dialog may be removed by clicking on .
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Spreadsheet

Associated with each Spartan Student document (including 
documents with only a single molecule) is a spreadsheet. This may 
be displayed by selecting Spreadsheet from the Display menu.

The spreadsheet comprises a series of rows (corresponding to 
different molecules in the document) and columns (corresponding 
to different properties). This gives rise to cells, the number of which 
is the product of the number of rows (molecules) and the number 
of columns (properties). The spreadsheet may be expanded or 
contracted by positioning the cursor at one of the corners, pressing 
the left mouse button and dragging the mouse.

Only one molecule from one document may be selected (although 
several molecules may be simultaneously displayed). Molecule 
selection follows either by clicking on the spreadsheet cell containing 
the molecule label or identifier (leftmost column), or by using the 

 and  buttons or the scroll bar at the bottom left of the screen. 
Molecules may be animated (stepped through in succession) using 
the  button at the bottom left of the screen. Animation speed may 
be adjusted from the Settings tab (Preferences under the Options 
menu; Chapter 10). Selection of a new molecule in the document 
results in deselection of the previously selected molecule. A molecule 
may be designated for permanent display by checking the box to 
the left of its identifier (Label) in the spreadsheet. The molecules 
in a document may either be translated and rotated in concert or 
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manipulated independently. This is controlled by Coupled under the 
Model menu (Chapter 5). By default (Coupled checked) molecules 
move in concert. Uncheck Coupled to move them independently.

Upon initial entry, all columns of the spreadsheet except the leftmost 
column, are blank. The leftmost column contains a label that may be 
changed either by directly typing a new label into the spreadsheet or 
into the Label box in the Molecule Properties dialog (see discussion 
earlier in this chapter). Additionally, default identifiers (M0001, 
...) may be replaced by chemical names if the molecule exists in 
the subset of the Spartan Spectra and Properties Database (SSPD) 
included with Spartan Student by right clicking inside the cell that 
contains the identifier and selecting Rename Selected Using SSPD 
from the menu that results. To replace all identifiers, left click on the 
header cell and then right click and select Rename Selected Using 
SSPD.

Information may be added to the spreadsheet in several ways:

From the Add Dialog

A selection of molecular properties may be entered into the 
spreadsheet by first clicking on the header cell of an empty column, 
and then clicking on Add... at the bottom of the spreadsheet. 
Alternatively, right click inside the header cell and then select 
Add... from the menu that results.

This leads to the Add dialog (comprised of three tabs). The 
Columns tab requests information about the properties of 
individual molecules, the Summaries tab provides summaries 
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of the properties for all molecules and the Linear Regression tab 
attempts to find relationships among properties of the molecules.
With the Columns tab selected, the following data are available.

Name	 molecule name as it appears in SSPD
Formula	 molecular formula
E	 energy (heat of formation, strain energy)
Eaq	 aqueous energy (heat of formation, strain energy) 

based on the SM5.4 model
rel. E	 energy (heat of formation, strain energy) relative to 

selected molecule
rel. Eaq	 aqueous energy (heat of formation, strain energy) 

relative to selected molecule based on the SM5.4 model
E HOMO	 energy of highest-occupied molecular orbital
E LUMO	 energy of lowest-occupied molecular orbital
Dipole	 dipole moment (in debyes)
Boltzmann	 Boltzmann distribution based on energy
Distribution	
Boltzmann	 Boltzmann distribution based on aqueous energy
Distribution (aq)	 as estimated from SM5.4 model 
Alignment Score	 1-R2/N, where R2 is the root mean square distance 

and N is the number of alignment centers. 1 is a 
perfect score

One or more properties may be added to the spreadsheet by 
clicking on their entries, and where appropriate specifying units 



Chapter 9	 89

from the Energy menu, varying temperature from the Temp menu 
(as applied to thermodynamic quantities and to the Boltzmann 
distributions), and finally clicking on OK or Apply. In the former 
case, the dialog is dismissed and in the latter it is left on screen. 
Clicking on Cancel or  removes the dialog.

Column totals, averages and Boltzmann-weighted averages may 
be accessed by clicking on the Summaries tab. Alternatively, 
click on an empty row header (instead of an empty column 
header) inside the spreadsheet prior to clicking on Add.... This 
leads to Summaries tab.

Totals	 sum of column values
Averages	 average of column values
Boltzmann Averages	 Boltzmann weighted average of column 

values
Boltzmann Averages (aq)	 Boltzmann weighted average of column 

values using energies corrected for aqueous 
environment based on the SM5.4 model

Clicking on one or more of these followed by clicking on OK or 
Apply, leads to the requested summaries as rows at the bottom 
of the spreadsheet, identified as Totals, Averages, etc. (one row 
for each).
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Finally, a linear regression analysis may be performed on the data 
in the spreadsheet. First click on the Linear Regression tab.

Select one entry from the Fit menu and one or more entries from 
the list under Using. Clicking on OK or Apply performs the linear 
regression analysis and places the results in a row at the bottom 
of the spreadsheet identified by Fit. As many regression analyses 
as desired may be performed on the data in the spreadsheet. 
The individual results will be entered as separate rows in the 
spreadsheet, with names Fit1, Fit2, etc.

Numerical Data

Numerical data may be entered by typing directly into the 
spreadsheet. A column header first needs to be specified. Double 
click on an empty column header cell, type in a name and press 
the Enter key (return key on Mac). Then, type the data into 
individual cells of the new column (press the Enter or return 
key following each data entry).
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User-Defined Expressions

An expression may be entered either into a header cell (in which 
case it refers to all entries in a column) or into an individual cell (in 
which case it refers only to a single entry). Expressions in the column 
header take the form name=formula, where formula may involve 
arithmetic operations, specialty functions, calculated quantities, 
conversion factors and constants in addition to numerical values. 
References to specialty functions, molecular mechanics and quantum 
chemical quantities and conversion factors and constants must be 
preceded by @. For example, mu = @DIPOLE typed into a header 
cell gives the dipole moment. Some functions have arguments, for 
example, c1 and c2 in the expression c12= @DISTANCE (c1,c2) refer 
to atoms c1 and c2, while 3 in the expression orbitalE=@HOMO 
(-3) designates the energy of the molecular orbital three orbitals below 
the HOMO. It is necessary to press the Enter key (return key on Mac) 
following entry of the expression into a cell. The leading name= is 
optional for entries in an individual (non-header) cell.

Arithmetic Operations Boolean Operations

+ addition > greater than
_ subtraction >= greater than or equal to
* multiplication < less than
/ division <= less than or equal to
^ raise to a power == equal to
  != not equal to
  | or
  & and

Mathematical Functions

ABS(x) absolute value LN(x) natural logarithm
ACOS(x) inverse cosine LOG(x) log (base 10)
ASIN(x) inverse sine SIN(x) sine
ATAN(x) inverse tangent SQRT(x) square root
COS(x) cosine TAN(x) tangent
EXP(x) exponential
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Specialty Functions

AVG (column name) average of values in column
FITVAL (fit name) column of fit values from regression analysis
MIN (column name) minimum of values in column
MAX (column name) maximum of values in column
NUM (column name) number of defined entries in column
ROW the number of the row in the spreadsheet
ROW(molecule name) the number of the row of molecule
REF(i, x) the value of the x referenced to row i
STDEV (column name) standard deviation of values in column
SUM (column name) sum of values in column

Calculated Quantities

ANGLE(i, j, k)	 angle involving atoms i, j, k (degrees)
AREA	 area of a user-defined plane (Å2)
DIHEDRAL(i, j, k, l)	 dihedral angle involving atoms i, j, k, l (degrees)
DISTANCE(i, j)	 distance involving atoms i, j (Å)
ELECTROSTATIC (i)	 electrostatic charge on atom i (electrons)
HOMOev(-n)	 energy of nth orbital below the HOMO (eV)
HOMOBETAev(-n)	 energy of the nth orbital below the β HOMO (eV)
INTERTIA(i)	 principle movements of inertia from largest (i=1) 

to smallest (i=3)	
ISOTOPE(i)	 mass number of atom i
LENGTH (i)	 length of bond i (Å)
LUMOev(+n)	 energy of the nth orbital above the LUMO (eV)
LUMOBETAev(+n)	 energy of the nth orbital above the β LUMO (eV)
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Conversion Factors and Constants

ANGS2AU Ångstroms to atomic units
AU2ANGS atomic units to Ångstroms
EV2HART eV to atomic units (hartrees)
EV2KCAL eV to kcal/mol
EV2KJ eV to kJ/mol
HART2KCAL atomic units (hartrees) to kcal/mol
HART2EV atomic units (hartrees) to eV
HART2KJ atomic units (hartrees) to kJ/mol
KCAL2EV kcal/mol to eV
KCAL2HART kcal/mol to atomic units (hartrees)
KCAL2KJ kcal/mol to kJ/mol
KJ2EV kJ/mol to eV
KJ2HART kJ/mol to atomic units (hartrees)
KJ2KCAL kJ/mol to kcal/mol
PI π

Table 9-5:	 Examples of User Defined Expressions

E/area = @ENERGY/@AREA	 energy divided by surface 
area

RelE = @ENERGY-@REF (6,@ENERGY)	 energy relative to energy 
of molecule in row 6

Eq = @EXP (-@ENERGY/592.1)	 equilibrium constant at 
room temperature

EnergyFilter = @ENERGY<-99.43	 “true” (≠0) for all energies 
<-99.43

RowFilter = @ROW>10	 “true” (≠0) all entries past 
row 10

From Post ( ) Buttons

Post buttons ( ) found in a number of properties dialogs provide 
an alternative method to the Add dialog for entering calculated 
properties into the spreadsheet. Note that some properties 
may require user specification. These include individual bond 
distances, angles and dihedral angles (available from Measure 
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Distance, Measure Angle and Measure Dihedral under the 
Geometry menu; Chapter 6), bond distance, angle and dihedral 
angle constraints (available from Constrain Distance, Constrain 
Angle and Constrain Dihedral under the Geometry menu; 
see discussion in Chapter 6), atomic charges, chemical shifts 
(available from the Atom Properties dialog; this chapter), the 
accessible area of an electron density surface, the polar area of 
an electrostatic potential map, minimum and maximum property 
values on a map and the value of the property at a specific location 
on a property map (available from the Surfaces Properties 
dialog; this chapter). With the exception of the property value 
on a map, post generates an entire column. Where atom labels 
are involved, for example, in defining a specific distance, post 
can be expected to yield consistent results for all molecules in a 
document only where the molecules are closely related, or where 
labels have been explicitly reassigned*. The property value on 
a map is posted only for the selected molecule. Post buttons 
are also available for CAS numbers, for heats of formation 
from the T1 thermochemical recipe and (where available) for 
experimental heats of formation contained in Spartan Student’s 
internal database.

Copy/Paste

Properties of one or more molecules in a document may be 
copied and then pasted into individual or multiple spreadsheet 
cells. These include (but are not restricted to) bond distances, 
angles and dihedral angles (Measure Distance, Measure 
Angle and Measure Dihedral under the Geometry menu), 
bond distance, angle and dihedral angle constraints (Constrain 
Distance, Constrain Angle and Constrain Dihedral under the 
Geometry menu), atomic charges and chemical shifts  (Atom 
Properties dialog), infrared frequencies and chemical shifts (IR 
Spectra and NMR Spectra dialogs, respectively) and the value 
of a property on a property map (Surface Properties dialog). To 
copy the spreadsheet, first highlight the numerical value of the 

*	 This may be done using the Atom Properties dialog (see discussion earlier in this chapter).
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property in the appropriate screen location (distances, etc.) or 
dialog (charges, etc.), then select Copy from the Edit menu, then 
click on the appropriate (destination) cell in the spreadsheet, and 
finally select Paste from the Edit menu. 

Each row in a spreadsheet corresponds to a molecule in a document, 
and new rows are automatically added in response to adding new 
molecules to the document. New molecules are added by building 
(New Molecule under the File menu; Chapter 3), by appending one 
or more existing documents each containing one or more molecules 
using either Append Molecule(s)... under the File menu (Chapter 
3), or by right clicking inside the header cell of the first available 
row and selecting Append from the menu that appears, by pasting 
from the clipboard, or by dragging  from the file system. To copy 
a molecule into the clipboard, first select (click on) it, and then 
select Copy from the Edit menu, or click on its identifier (left most 
column) in its spreadsheet, and then select Copy from the Edit menu. 
Alternatively right click either on the molecule or on its identifier in 
the spreadsheet and select Copy from the menu that appears. Use of 
the clipboard permits several molecules to be selected (and copied) 
at once using the Shift and Ctrl keys in the usual manner. To copy 
the contents of the clipboard to its destination, click on an empty 
row header in the spreadsheet (for the destination document), and 
then select Paste from the Edit menu. An alternative to the two-step 
Copy-Paste procedure is to drag the molecule or set of molecules 
from one spreadsheet to another.

A row (molecule) may be deleted from a spreadsheet, either by first 
selecting the molecule and then selecting Delete Molecule from the 
File menu, or by first clicking on its identifier in the spreadsheet 
(leftmost column) and then either clicking on the Delete button at 
the bottom of the spreadsheet, or by right clicking on its identifier in 
the spreadsheet and then selecting Delete Selected from the menu 
that appears. In all cases, a warning is provided prior to deletion. 
An entire column in the spreadsheet may be deleted by first clicking 
inside its header cell and then clicking on the Delete button (or 
Delete Selected from the menu).
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Rows in the spreadsheet may be sorted according to the numerical 
values in any column either by first clicking inside the header cell 
and then clicking on the Sort button at the bottom of the spreadsheet 
or by right clicking inside the header cell and selecting Sort from 
the menu that appears. The rows are placed in ascending order, the 
smallest (least positive) value of the selected property at the top, 
largest (most positive) value at the bottom. To sort in descending 
order, hold down the Shift key before clicking on the Sort button or 
selecting Sort from the menu.

Information in one or more columns of the spreadsheet may be 
formated by right clicking inside the header cell(s) and selecting 
Format Selected from the menu that appears.

Format as desired and click on OK to remove the dialog. The full 
contents of the spreadsheet may be formated by right clicking inside 
the header cell for the left most column and then selecting Format 
Selected from the menu.

A button at the bottom right of the spreadsheet toggles between 
numerical representation of data, f(x), and formula presentation, =?.

The spreadsheet may be printed by right clicking in the spreadsheet 
and selecting Print. 

As many spreadsheets as desired (corresponding to the same or 
to different documents) may be open on screen. A spreadsheet is 
removed when the associated document is closed and may also be 
removed by clicking on .
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The contents of the spreadsheet may be brought into Excel™ using the 
clipboard. Select whatever cells are to be copied, select Copy from the 
Edit menu. Alternatively, right click with the proper cells selected and 
select Copy from the menu that appears. Paste into Excel.

The contents of an Excel spreadsheet may be brought into Spartan 
Student. Copy whatever information is to be transferred from Excel, 
move into Spartan Student, click on the appropriate cell and select 
Paste from the Edit menu (or right click on the appropriate cell and 
select Paste from the menu that appears). Note, that information on the 
clipboard that goes beyond the number of rows in Spartan Student’s 
spreadsheet will be ignored.

Plots ( )

Plots may be constructed from data in a spreadsheet and a variety of 
simple curves fit to these data. Selection of Plots... from the Display 
menu leads to the Plots dialog.

To construct a plot, select an item from the X Axis menu to designate 
the molecular property to be displayed on the X axis, then click on 
one or more items from the Y Axes list to designate properties to 
be displayed along the Y axis and finally click on Add. (Repeated 
clicking on a property in the Y Axes list turns it on and off.) The 
dialog is removed from the screen and a plot appears.
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The plot window can be detached from the screen by clicking on 
. It can be edited (a title and axis label supplied and axis ranges 

changed) by clicking on .
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The data points on a plot initially presented are connected by a 
smooth curve. They may be fit to a straight line (Least Square) or 
to a periodic function (Fourier).

Additional plots may be added by clicking on . This will lead to 
a set of tabs at the top of the dialog. Only one plot may be displayed 
at a time. A plot may be deleted by clicking on its tab and then 
clicking on .

Reactions...

Data in a Spartan Student document may be used to caculate reaction 
energies including activation energies.

∆E  =  NP1 Eproduct1  +  NP2 Eproduct2  –  NR1 Ereactant1  +  NR2 Ereactant2

NP1 and NP2 are the numbers of product molecules 1 and 2 and NR1 
and NR2 are the numbers of reactant molecules 1 and 2. Selection of 
Reactions... from the Display menu leads to the Reactions... dialog.

Two sets of menus under Reactants: and two sets of menus under 
Products: specify the number of each reactant and product and 
identify them. The latter correspond to the labels (identifiers) of the 
molecules in the document, plus a null entry <none>.  The overall 
reaction needs to be mass balanced.

The Use menu identifies the source of the energies to be used in the 
reaction energy calculation.
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SSPD refers to heats of formation drawn from the T1 data provided 
in the Spartan Spectra and Properties Database (SSPD), Current 
Document refers to energies in document and Current Document 
(aq) refers to energies in the document that have been empirically 
corrected for aqueous solvent using the SM5.4 model.

A reaction energy (in kJ/mol) is computed by clicking on Compute 
Energies at the bottom left of the dialog.

The results of a reaction energy calculation may be printed by right 
clicking inside the display area of the Reactions dialog and selecting 
Print from the menu that results.

The Reactions dialog is closed by either clicking on OK or .
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Chapter 10
The Options Menu

Functions under the Options menu* set default colors, fonts, user 
preferences and van der Waals radii, locate databases, set icon 
displays, identify/change URL’s for on-line accesses, and monitor 
executing jobs. 

Preferences...

This sets up preferences relating to the graphical user interface 
(Settings), and to molecule displays (Molecules). It permits changes 
to default van der Waals radii used for space-filling models as well 
as for calculating molecular surface areas and volumes (VDW 
Radii). It also specifies the locations of databases (Paths), specifies 
platform dependent features (X-Platform), specifies which icons are 
to be displayed (Toolbars) and specifies URLs (URLs) for on-line 
connections. Selection results in one of seven dialogs, depending on 
which tab has been selected in the previous entry. Clicking on a tab 
brings up the associated dialog. To exit a Preferences dialog click on 
OK. Clicking on Cancel or  exits the dialog without instituting 
any changes.

*	 Preferences are also under the Spartan Student menu on the Macintosh version.
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Settings

(i)	 View:  orthogonal, perspective
	 Controls the view of structural models and graphics.

(ii)	 Toolbar Style: text, small icons, medium icons, large 
icons

	 Controls presentation style (text vs. icons) and size of the icons.

(iii)	 Stereo: off, red-cyan
	 Turns red-cyan stereographic display on and off.

(iv)	 Global Rotate:  screen ctr., molecule ctr.
	 Screen ctr. rotates all molecules about a common center, 

while molecule ctr. rotates each molecule about its own 
center.

(v)	 Animation Speed
	 A slider bar controls the maximum speed for animations. 

This has become an important control as the performance 
of graphics cards has increased.

(vi)	 Pin New Documents
	 If checked, defaults to display of any new documents (from 
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building or brought in from the File menu) irrespective of 
whether or not they are selected. Does not affect the status of 
existing documents. Pin New Documents has no meaning 
unless Show Document Tabs (see discussion following) 
is checked.

(vii)	 Show Document Tabs
	 If checked, this displays a tab at the bottom of the screen 

for each open document. Only if the box to the left of 
the tab is checked will the molecule display (if it is not 
the selected document). If Show Document Tabs is not 
checked, the display corresponds to previous versions of 
Spartan Student.

(viii)	 Split-Tubes
	 If checked, the tubes in tube and ball-and-spoke models are 

split to designate multiple bonds.

(ix)	 Auto-Gen Graphics
	 If checked, graphics calculations will be performed in the 

interface (without having to submit the job). Does not pertain 
to orbital displays initiated from Orbital Energies under 
the Display menu. Note, however, that graphics calculations 
on documents containing more than 25 molecules will not 
be performed in the interface irrespective of this setting.

(x)	 Tumble
	 If checked, allows automatic tumbling of molecule. To 

tumble a molecule, select it, press the left mouse button, 
move the mouse and release the button. To stop tumbling, 
left click.

(xi)	 Keep Verbose
	 If checked, keeps extended (verbose) output. Verbose output 

is normally discarded upon successful completion, but 
may be useful for identifying the source of problems for 
calculations that have not successfully completed or have 
led to suspicious results. (Verbose output is automatically 
kept for a job that has abnormally terminated.) Note that 
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keeping verbose output significantly increases the size of 
the Spartan Student document.

(xii)	 Proton NMR Averaging
	 If checked, averages protons that are likely to be equivalent 

by conformational equilibrium.

(xiii)	 Polar Area Range
	 Set potential (in kJ/mol) for calculating polar area from 

elecrostatic potential map. Values > | range | contribute to 
polar area. Default is 100 kJ/mol.

(xiv)	 Accessible Area Radius
	 Set sphere radius (in Å) for determining accessible area. 

Default is 1.0.

Molecule

This specifies default settings for model appearance. These settings 
may be overridden for a specific molecule (or list of molecules) 
using entries under the Model menu.
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(i)	 Model:  Wire, Ball and Wire, Tube, Ball and Spoke, Space 
Filling

	 Controls default model style.

(ii)	 Surface Style: Bands
	 If checked, property maps will be shown in terms of discrete 

color bands, the number of which is set in the menu to the 
right. Otherwise, property maps will be shown as continuous 
displays.

(iii)	 Show: Constraints, Frozens, Points, Planes, Reactions
	 If checked, constraints and frozen markers, points and planes, 

and reaction arrows will always be shown as part of the 
model. Otherwise, they will be shown only in the appropriate 
mode.

(iv)	 Atom Labeling: Label, Element, Mass Number, R/S, 
Electrostatic Charge, Strand: Res\Label, Exposed Area, 
Chem Shift

(v)	 Bond Labels
	 If checked, bond labels will be shown.

(vi)	 Point Labels
	 If checked, point labels will be shown.

(vii)	 Plane Labels
	 If checked, plane labels will be shown.

(viii)	Constraint Labels
	 If checked, constraint labels will be shown.

(ix)	 Residue Labels
	 If checked, residue labels will be shown.

(x)	 Reaction Labels
	 If checked, reaction arrow labels will be shown.
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VDW Radii

This provides a list of van der Waals radii

To order the list by element name click on Element, and by atomic 
radius click on VDW Radius. Individual entries may be changed 
from default values by first clicking on the entry and then entering 
a new value. The currently selected entry may be returned to its 
default radius by clicking on Reset Selected at the bottom of the 
dialog, and the full set of radii may be returned to their default 
values by clicking on Reset All at the bottom of the dialog.
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Paths

This allows setting up of paths for the SSPD included with Spartan 
Student.

Other databases may be added, in particular, the subset of the 
Spartan Molecular Database (SMD). 
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X-Platform

This controls platform (computer) dependent features.

Output/Spreadsheet Windows controls whether these are Free, that 
is, able to move outside Spartan Student’s main window or Confined 
inside this window. Free is only appropriate for large monitors.
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Builder Selection Method controls whether selection of model 
kit is from two rows of Buttons or from a vertical Tab. The latter 
is needed for very small screens as for example found on netbook 
computers.

Toolbars

A listing of all icons available for entries in the File, Geometry, 
Build and Display menus is provided. If checked, the icon will 
appear at the top of the Spartan Student screen.
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URL’s

Lists URL’s for access to experimental structural and spectral 
databases and to Wikipedia.

Colors

This alters default colors. Selection leads to the Colors dialog.

After selecting an object, its color may be set by choosing from 
the palette, moving the cursor inside the window of colors, or by 
selecting  either a set of hue, saturation and values, or red, green and 
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blue settings. The default color may be reset by clicking on Restore 
Default Color. Color selection applies to all objects of the same type, 
for example, all carbon atoms, and not just to the selected carbon. 
Further control of colors is available from Utilities/Style dialogs 
associated with Properties dialogs (Properties under the Display 
menu; Chapter 9). Clicking on  removes the dialog.

Fonts/Graphic Fonts

This selects fonts, style and size for menus and labels attached to 
molecules (Labels and Configure... under the Model menu; Chapter 
5), and plots (Plots... under the Display menu; Chapter 9). Selection 
leads to the Fonts dialog.

Selections are made from the Font, Font Style and Size menus. 
Clicking on OK dismisses the dialog with selections kept. Clicking 
on Cancel or on  dismisses the dialog but selections are lost.
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Monitor

This provides a listing of all executing/queued jobs and their status. To 
see accumulated output for an executing job, click on its name. A ball-
and-spoke model of the selected (executing) job will be displayed in a 
window to the right of the dialog. It can be manipulated using the usual 
mouse commands (you need to position the cursor inside the window). 
Model style cannot be changed. Note that (except for molecular 
mechanics and semi-empirical calculations) the structure is updated 
throughout an equilibrium geometry of transition state optimization, 
and bond lengths, angles and dihedral angles can be queried. 

To kill a job, click on its name, and then select Terminate from the 
Actions menu at the top of the dialog (or right click on its name and 
select Terminate from the menu that appears). To start a queued job 
(irrespective of the imposed queue limits; see previous discussions 
under Jobs), click on its name and select Start from the Actions 
menu (or right click on its name and select Start from the menu that 
appears).

The Monitor may be removed either by selecting Exit from the File  
menu or by clicking on  at the top of the dialog.
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Calculator

Selection brings up a Calculator.

This functions the same way as a normal pocket calculator. The 
Calculator is removed by clicking on .

Model Kit

If checked, this signifies that a model kit (organic, inorganic, peptide, 
nucleotide or substituent) is to remain on screen. Does not apply to 
ChemDraw.

File Toolbar, Geometry Toolbar, Build Toolbar, Display Toolbar

If checked, this provides display of toolbars that access functions 
contained in the File, Build, Geometry and Display menus, 
respectively.

Cascade, Tile

Arranges open windows in a cascade or as tiles on top of Spartan 
Student’s main window (Windows only).
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Chapter 11
The Activities Menu

The Activities menu permits on-screen display of the full set of Spartan 
Student tutorials and a series of topics of practical relevance to 
molecular modeling. It also allows a Wikipedia page to be brought 
up (external to Spartan).

Tutorials/Topics

Selection of Tutorials or Topics brings up a dialog with either the 
Tutorials or Topics tab selected (Tutorials tab shown).

Tutorials are specified by a chapter number (in the Spartan Student 
Tutorials) and by name. Selection followed by clicking on Open leads 
to a scrollable window containing the appropriate text. This may be 
moved about the screen but may not be sized.
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Topics are specified by name only (in the upper half of the dialog).

Note that the full User’s Guide is available as a PDF under the Help 
menu (see next chapter).

Look Up in Wikipedia...

Selection results in a dialog.

Entering a query followed by clicking on OK leads to a Wikipedia 
page. This occupies a window that is external to Spartan Student.
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Chapter 12
The Help Menu

This chapter describes help.

Help

This provides information relating to application of computational 
methods available in Spartan Student, as well as technical details 
regarding the program’s operation. Help also provides a link to 
Wavefunction’s website. Help files are HTML documents and require 
that Internet Explorer is installed to access them.

Spartan Student Tutorials, Spartan Student Overview (this document) 
and A Guide to Molecular Mechanics and Quantum Chemical 
Calculations are also available (as PDF files) under Help.

Finally, note that several dialogs, in particular, the Calculations dialog 
incorporate imbedded help messages. Clicking on  at the upper 
right, followed by clicking on a menu, button, etc. in the dialog gives 
rise to a brief informative message about the object queried.
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About...*

Provides information about the user’s release of Spartan Student.

*	 About is located under the Spartan Student menu on the Macintosh version.
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Appendix A
Capabilities and Limitations

Molecular Mechanics Models1

The MMFF molecular mechanics model is available for the calculation 
of energy (a combination of strain energy and intramolecular 
interaction energy), equilibrium geometries, equilibrium conformers 
and vibrational frequencies. Energies may be corrected for the effects 
of aqueous solvent. There are no atom limits for molecular mechanics 
calculations.

Semi-Empirical Models1

The PM3 semi-empirical model is available for calculation of heats of 
formation, wavefunctions, equilibrium and transition-state geometries 
and vibrational frequencies. The elements H-Ne, Mg-Ar, Ca, Ti-
Br, Zr, Mo-Pd, Cd-I, Hf-Pt and Hg-Bi and Gd are supported. PM3 
calculations are limited to 75 atoms.

Hartree-Fock Models1-3

Hartree-Fock models are available for calculation of energies and 
wavefunctions, equilibrium and transition-state geometries and 
vibrational frequencies with STO-3G, 3-21G, 6-31G* and 6-311+G** 
basis sets. Hartree-Fock calculations are limited to 30 atoms.

Density Functional Models1,

B3LYP and EDF2 density functional models are available for 
calculation of energies and wavefunctions, equilibrium and transition-
state geometries and vibrational frequencies with both 6-31G* and 
6-311+G** basis sets. NMR chemical shifts are available for the 
B3LYP/6-31G* and EDF2/6-31G* models only. Density functional 
calculations are limited to 30 atoms.
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MP2 Møller-Plesset Models1

The MP2 Møller-Plesset model is available for calculation of energies 
and wavefunctions and equilibrium and transition-state geometries 
with 6-31G* and 6-311+G** basis sets. Vibrational frequencies are 
also available, but are very costly in terms of computation. MP2 
calculations are limited to 20 atoms.

Solvent Models

Spartan Student supports the SM5.0R4 (for molecular mechanics 
calculations) and SM5.45 (for quantum chemical calculations) 
empirical solvation models to estimate the aqueous solvation energy. 
Both methods are parameterized for H, C–F, S–Cl, Br and I. Solvation 
energies are added to gas phase energy calculations to provide an 
aqueous energy (Eaq).

Properties and Spectra

The properties module (that is automatically called from the molecular 
mechanics module or one of the quantum chemical modules) 
provides for text output printing, population analyses based on fits 
to electrostatic potentials), evaluation of thermodynamic quantities 
(enthalpy, entropy, free energy and heat capacity), and calculation of 
the dipole moment. 

The properties module is also responsible for calculating quantities 
related to infrared spectra (vibrational frequencies and intensities), 
and NMR chemical shifts (13C chemical shifts are correlated for local 
environment). IR spectra calculations may be carried out with molecular 
mechanics models, semi-empirical models, Hartree-Fock models, 
B3LYP, EDF2 and MP2 models. NMR spectra calculations may be 
carried out only with the B3LYP/6-31G* and EDF2/6-31G* models.

Graphical Models

The graphics module provides for data preparation associated with the 
display as surfaces, property maps and slices of molecular orbitals, 
electron densities, spin densities, electrostatic potentials and local 
ionization potentials. The sizes of electron density surfaces (and of 
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property maps based on electron density surfaces) may be chosen 
either using a specific value of the density or a value that encloses a 
specific percentage of the total number of electrons. Accessible and 
inaccessible regions may be distinguished for electron density surfaces 
and all property maps based on electron density surfaces.

Database

The database supported with Spartan Student is a subset of the Spartan 
Spectra and Properties Database (SSPD). It contains structures, 
energies, T16 heats of formation, IR and NMR spectra and diverse 
molecular properties for ~5,000 molecules obtained from EDF2/6-
31G* calculations. In addition, it contains the wavefunction allowed 
on-the-fly calculation and display of the full variety of graphical 
surfaces and property maps. The full version of SSPD (currently 
105,000 molecules) may be licensed separately. Also available is an 
~5,000 molecule subset of the Spartan Molecular Database. This does 
not contain spectra, nor does it include the wavefunction. However, 
the SMD subset includes calculations from multiple theoretical 
models. The full version of SMD (currently 600,000 records and 
150,000 molecules) is also available. 

1.	 For a general discussion and assessment of the techniques and methods available in Spartan 
Student, see: W.J. Hehre, A Guide to Molecular Mechanics and Quantum Chemical 
Calculations, Wavefunction, Inc., Irvine, CA 2003. This is available from Wavefunction’s 
website (www.wavefun.com).

2.	 For a review of the quantum chemical methods utilized in Spartan Student (except for the 
PM3 semi-empirical method) with emphasis on recent developments, see: Y. Shao, L.F. 
Molnar, Y. Jung, J. Kussmann, C. Ochsenfeld, S.T. Brown, A.T.B. Gilbert, L.V. Slipchenko, 
S.V. Levchenko, D.P. O’Neill, R.A. DiStasio Jr., R.C. Lochan, T. Wang, G.J.O. Beran, 
N.A. Besley, J.M. Herbert, C.Y. Lin, T. Van Voorhis, S.H. Chien, A. Sodt, R.P. Steele, V.A. 
Rassolov, P.E. Maslen, P.P. Korambath, R.D. Adamson, B. Austin, J. Baker, E.F.C. Byrd, H. 
Dachsel, R.J. Doerksen, A. Dreuw, B.D. Dunietz, A.D. Dutoi, T.R. Furlani, S.R. Gwaltney,  A. 
Heyden, S. Hirata, C-P. Hsu, G. Kedziora, R.Z. Khalliulin, P. Klunzinger, A.M. Lee, M.S. Lee, 
W.Z. Liang, I. Lotan, N. Nair, B. Peters, E.I. Proynov, P.A. Pieniazek, Y.M. Rhee, J. Ritchie, E. 
Rosta, C.D. Sherrill, A.C. Simmonett, J.E. Subotnik, H.L. Woodcock III, W. Zhang, A.T. Bell, 
A.K. Chakraborty, D.M. Chipman, F.J. Keil, A.Warshel, W.J. Hehre, H.F. Schaefer, J. Kong, 
A.I. Krylov, P.M.W. Gill and M. Head-Gordon, Phys. Chem. Chem. Phys., 8, 3172 (2006).

3.	 For an older account see: W.J. Hehre, L. Radom, P.v.R. Schleyer and J.A. Pople, Ab Initio 
Molecular Orbital Theory, Wiley, New York, 1986.

4.	 G.D. Hawkins, C.J. Cramer and D.G. Truhlar, J. Phys. Chem. B., 101, 7147 (1997).
5.	 C.C. Chambers, C.J. Hawkins, C.J. Cramer, D.G. Truhlar, J. Phys. Chem., 100, 16385 (1996).
6.	 W.S. Ohlinger, P.E. Klunzinger, B.J. Deppmeier, W.J. Hehre; J. Phys. Chem. A., 113, 10, 2165 (2009).
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Appendix B
Menus

Spartan Student Screen

File

New	 Brings up a model kit for molecule 
building; accesses ChemDraw (Windows 
only)

Open...	 Opens (imports) a molecule
Close	 Closes a molecule
Save	 Saves (exports) a molecule		
Save As...	 Saves a molecule as a Spartan Student 

document under a user-specified name
New Molecule	 Adds a molecule to an existing list; brings 

up a model kit for molecule building; 
accesses ChemDraw (Windows only)

Delete Molecule	 Deletes a molecule (or molecules) from a list
Append Molecule(s)...	 Appends molecules to an existing list
Search Database by Name	 Searches the Spartan Student database 

by name or partial name
Access CACTUS	 On-line access to the National Cancer 

Institute CACTUS Database
Access PDB	 On-line access to the Protein Data Bank 

by PDBid
Print...	 Prints on-screen display; also prints 

contents of output window and the 
Spreadsheet 

Start/Stop QuickTime	
Recording	 Starts and stops QuickTime recording
	 of contents of main Spartan Student screen
Exit	 Exits Spartan Student
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Edit

Undo	 Undoes previous operations
Cut	 Moves the current molecule or contents of the 

selection box to the clipboard
Copy	 Copies the current molecule or contents of 

the selection box to the clipboard
Paste	 Pastes contents of the clipboard to the screen
Select All	 Selects the entire contents of output dialog or 

spreadsheet
Find...	 Locates a text string in the output dialog or 

an on-screen molecular fragment
Find Next	 Locates next occurrence of a text string or 

molecular fragment
Center	 Centers the molecule on screen; applies to all 

molecules in a document
Clear	 Clears the selected molecule

Model 	

Wire	 Displays structure as wire-frame model	
Ball and Wire	 Displays structure as ball-and-wire model
Tube	 Displays structure as tube model
Ball and Spoke	 Displays structure as ball-and-spoke model
Space Filling	 Displays structure as space-filling model
Hide	 Hides structure model from view
Global Model	 Applies model type and labels of current 

molecule to all molecules in the document
Coupled	 Couples motions of all molecules in the 

document
Hydrogens	 Toggles hydrogens on and off
Labels	 Toggles labels on and off
Ribbons	 Toggles ribbons on and off
Ramachandran Plot	 Creates a Ramachandran plot based on a 

proton structure input from PDB
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Hydrogen Bonds	 Toggles hydrogen bonds on and off
Configure...	 Labels atoms, bonds, etc., provides information 

about polypeptides/polynucleotides residues 
and designates ribbon displays

Geometry

Measure Distance	 Displays and/or sets bond distance
Measure Angle 	 Displays and/or sets bond angle
Measure Dihedral	 Displays and/or sets dihedral angle
Freeze Center	 Freezes selected atomic positions
Constrain Distance	 Constrains bond distance
Constrain Angle	 Constrains bond angle
Constrain Dihedral	 Constrains dihedral angle
Define Point	 Defines a point as a geometric mean of a set 

of atoms; defines ligand point as a position 
that is perpendicular to the centroid of a plane 
made by three or more atoms

Define Plane	 Defines a plane made by three or more atoms
Align	 Aligns molecules in a document according to 

selected atoms

Build

View	 Removes the model kit
Add Fragment	 Brings up a model kit that contains libraries 

of atomic fragments, functional groups, rings  
and ligands; accesses user-defined libraries; 
provides access to ChemDraw (Windows only)

Delete 	 Deletes atoms, bonds, points, planes, etc.
Make Bond	 Makes bonds between free valences or atoms
Break Bond	 Breaks a bond
Minimize	 Performs energy minimization using molecular 

mechanics
Guess Transition State	Provides transition-state guess based on 

reaction database or, lacking a database entry, 
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based on linear synchronous transit

Setup

Calculations...	 Sets up molecular mechanics and quantum 
chemical calculations; specifies calculation 
of IR and NMR spectra

Surfaces	 Sets up generation of and displays graphical 
surfaces

Submit	 Submits job to the execution queue

Display

Output	 Displays text output
Properties 	 Displays molecule, bond and atom properties 

as well as information about geometrical 
constraints and graphical surfaces		

Surfaces	 Sets up generation of and displays graphical 
surfaces (same as entry in Setup menu)

Spectra	 Displays IR and NMR spectra, animates 
vibrational modes, and accesses on-line 
experimental spectral databases; fits calculated 
infrared spectra to experimental spectra

Spreadsheet	 Displays spreadsheet
Plots...	 Creates plots from the data in the spreadsheet
Reactions	 Calculates reaction energies using data either 

from current document or from the Spartan 
Spectra and Properties Database

Options

Preferences...	 Sets various run-time and labeling preferences
Colors	 Sets screen and model colors
Fonts..., 	 Sets fonts for labels and plot displays
Graphics Fonts...	
Monitor	 Monitors and allows for killing executing jobs 

and bypassing queue to start jobs
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Calculator	 Pocket calculator

Help

Help	 Provides information about the performance 
and timing of computational methods in 
Spartan Student; provides information about 
using graphical models in Spartan Student

About...	 Provides program version information for 
citation and support

Contextual (Right Click to Access)

Main Screen

Copy	 Copies selected molecule to the clipboard
Paste 	 Pastes the contents of the clipboard into the 

selected document
Delete Selected	 Deletes selected molecule from document
Properties	 Brings up the Molecular Properties dialog

Spreadsheet

Copy	 Copies text of selected cell or cells to the 
clipboard. If leftmost cell (or cells) selected, 
copies molecule(s) to the clipboard

Paste 	 Pastes the contents of the clipboard into 
selected cells. If leftmost cell (or cells) 
selected, either pastes text or molecule(s) 
depending on menu choice

Add	 Brings up the Add dialog (spreadsheet) 
for adding calculated quantities into the 
spreadsheet 

Sort	 Sorts the column from low to high. Pressing 
the Shift key prior to menu selection sorts 
from high to low
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Format Selected	 Formats selected cell(s), selected column(s) 
if selection is in a header cell, or entire 
spreadsheet if selection is header cell of 
leftmost column

Delete Selected	 Deletes selected molecule(s) from document
Append	 Appends the contents of Spartan Student 

document(s) to the spreadsheet (corresponding 
to the selected document)

Rename Selected	 Rename selected molecule(s) with names in the
Using SSPD	 Spartan Spectra and Properties Database; 

appears only when leftmost cell(s) selected
Properties	 Brings up the Molecular Properties dialog

Reactions

Copy	 Copies selected text to the clipboard
Print 	 Prints selected text

Output Window

Copy	 Copies selected text to the clipboard
Print 	 Prints selected text
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Appendix C
Units

Geometries

Cartesian coordinates are given in Ångstroms (Å), and in atomic 
units (au).

Bond distances are given in Å and in au. Bond angles and dihedral 
angles are given in degrees (°).

Surface areas, accessible surface areas and polar surface areas are 
available in Å2 and volumes in Å3, and in au2 (au3).

1 Å = 0.1 nm=1.889762 au

Energies, Heats of Formation and Strain Energies, Zero-Point 
Energies, Enthalpies and Gibbs Energies and Entropies

Total energies from Hartree-Fock calculations are available in au, 
kcal/mol, kJ/mol and electron volts (eV).

Experimental heats of formation as well as those from semi-empirical 
calculations and from thermochemical recipes are available in kJ/
mol, au, kcal/mol and eV.

Strain energies from molecular mechanics calculations are available 
in kJ/mol, au, kcal/mol and eV.

Energies, heats of formation and strain energies corrected empirically 
for the effects of aqueous media are given in the same units as the 
corresponding gas-phase quantities.

Zero-point energies, enthalpies and Gibbs energies available in kJ/
mol, kcal/mol and au/mol. Entropies are available in kJ/mol•degree, 
kcal/mol•degree and au/mol•degree. 

Orbital Energies

Orbital energies are available in eV, kcal/mol, kJ/mol and au.
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Energy Conversions

 au kcal/mol kJ/mol eV

1 au - 627.5 2625 27.21
1 kcal/mol 1.593 (-3) - 4.184 4.337 (-2)
1 kJ/mol 3.809 (-4) 2.390 (-1) - 1.036 (-2)
1 eV 3.675 (-2) 23.06 96.49 -
a) exponent follows in parenthesis, e.g., 1.593 (-3) = 1.593 x 10-3

Electron Densities, Spin Densities, Dipole Moments, Charges, 
Electrostatic Potentials and Local Ionization Potentials

Electron densities and spin densities are given in electrons/au3.

Dipole moments are given in debyes.

Atomic charges are given in electrons.

Electrostatic potentials are given in kJ/mol.

Local ionization potentials are given in eV.

Vibrational Frequencies

Vibrational frequencies are given in wavenumbers (cm-1).

Chemical Shifts, Coupling Constants

Chemical shifts are given in parts-per-million (ppm) relative 
to the following standards: hydrogen, tetramethylsilane; 
carbon, tetramethylsilane; nitrogen, nitromethane; fluorine, 
fluorotrichloromethane; silicon, tetramethylsilane, phosphorous, 
phosphoric acid.

Coupling constants are in ppm.
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Appendix D
Citation

The proper citation for Spartan Student is as follows:

Spartan Student
Wavefunction, Inc.

Irvine, CA

Except for molecular mechanics and semi-empirical models, the 
calculation methods used in Spartan Student have been documented 
in: Y. Shao, L.F. Molnar, Y. Jung, J. Kussmann, C. Ochsenfeld, S.T. 
Brown, A.T.B. Gilbert, L.V. Slipchenko, S.V. Levchenko, D.P. O’Neill, 
R.A. DiStasio Jr., R.C. Lochan, T. Wang, G.J.O. Beran, N.A. Besley, 
J.M. Herbert, C.Y. Lin, T. Van Voorhis, S.H. Chien, A. Sodt, R.P. 
Steele, V.A. Rassolov, P.E. Maslen, P.P. Korambath, R.D. Adamson, 
B. Austin, J. Baker, E.F.C. Byrd, H. Dachsel, R.J. Doerksen, A. Dreuw, 
B.D. Dunietz, A.D. Dutoi, T.R. Furlani, S.R. Gwaltney,  A. Heyden, 
S. Hirata, C-P. Hsu, G. Kedziora, R.Z. Khalliulin, P. Klunzinger, A.M. 
Lee, M.S. Lee, W.Z. Liang, I. Lotan, N. Nair, B. Peters, E.I. Proynov, 
P.A. Pieniazek, Y.M. Rhee, J. Ritchie, E. Rosta, C.D. Sherrill, A.C. 
Simmonett, J.E. Subotnik, H.L. Woodcock III, W. Zhang, A.T. Bell, 
A.K. Chakraborty, D.M. Chipman, F.J. Keil, A.Warshel, W.J. Hehre, 
H.F. Schaefer, J. Kong, A.I. Krylov, P.M.W. Gill and M. Head-Gordon, 
Phys. Chem. Chem. Phys., 8, 3172 (2006).




